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DEPARTMENT OF COMPUTER SCIENCE 

 

 

Board of Studies Dated: 17-10-2025 

 

Meeting of the Board of studies is held at NRC Room for the Department of Computer Science, NPS 

GDC Women (A), Chittoor with the following agenda. 

 

Agenda 

 Curriculum Design for all the I  & I I  Semesters for B.Sc. (Honors)-Computer Science 

 Designing of Course Outcomes and Course Objectives 

 

 Identifying /inclusion of components of Skill Development, Employability and 

Entrepreneurship in the curriculum 

 Additional inputs into the curriculum 

 Designing Model Question Papers and identifying potential paper setters 

 Innovative Teaching – Learning Methodology (Learner Centric) 

 Curriculum for the Certificate Courses 

 

 Academic activities of the Department 

 Any other proposal with the permission of the chair 

 

 

 

 

(Smt. Y Jnapika) 

      CHAIRPERSON 

BOARD OF STUDIES 



 

Minutes and Resolutions 

 

 The BOS Team have given the following inputs on the BOS Meeting-1: 

 

 No changes required in the framed syllabus of the course-1 “Computer Fundamentals and Office 

Automation(25BCS101T)” in Semester-1 

 In the Course-2 “Problem Solving using C (25BCS102T)” of semester-1, suggested to swap the 

topic “Dynamic Memory Management: Introduction, Functions-malloc, calloc, realloc, free” from 

unit -V to Unit -IV as it is interlinked with pointers. 

 In the Course-2 “Problem Solving using C (25BCS102T)” of semester-1, suggested to include 

“Files operations: Working with text files - modes: opening, reading, writing and closing text files” 

in unit-V as required and emphasized in further courses later. 

 In the Course-3 “Data Structures using C (25BCS203T)” of semester-2, suggested to specify 

clearly which notation in Asymptotic Notations will be covered in the syllabus – and finalized to 

include “Big -O Notation”. 

 In the Course-3 “Data Structures using C (25BCS203T)” of semester-2, suggested to remove 

Abstract Data Type (ADT)” from unit-1, to avoid ambiguity. 

 In the Course-3 “Data Structures using C (25BCS203T)” of semester-2, suggested to include only 

Stack and Queue data structures and remove Stack ADT and Queue ADT” from unit-4, as it is 

good to study in advanced data structures. 

 In the Course-3 “Data Structures using C (25BCS203T)” of semester-2, suggested to specify 

clearly which applications of Graphs is covered in the syllabus – and finalized to include “Finding 

Shortest Path using Dijkstra’s algorithm”. 

 No changes required in the framed syllabus of the course-4 “Digital Logic Design (25BCS204T)” 

in Semester-2. 

 Appropriate changes were made or incorporated in the skill courses “AI Fundamentals” in 

semester-I and “Applications of AI” in semester-II for the benefit of all groups of students. 

 

The above suggestions are agreed by all the BOS members also incorporated while framing the UG 

syllabus for the B.Sc., Computer Science (Major) and AI related skills courses for all groups during first 

year. The approved syllabus is followed from A.Y.2025-26. 

 

 

Signature of the Members    Signature of the BOS Chairman 



CONSOLIDATED REPORT OF BOARD OF STUDIES FOR THE YEAR 2025-26 

 

The Meeting Board of Studies of Computer Science & Applications department was convened on 

17-Oct-2025 under the Chairmanship of Smt, Y Jnapika Head / Lecturer-in-charge of Department of 

Computer Science and Applications. The following members are present 

 

S.No. Name Designation Signature 

1 Prof. M. Humera Khanam University Nominee 
 

2 Dr. G. Vijay Kumar Local Nominee 
 

3 Manoj Prabhakar Darsi Local Nominee 
 

4 Murali Mohan M Industrial Nominee 
 

5 Smt. M. Padmavathi Faculty Member 
 

6 Sri. Shaik. Munwar Subject/Special Course 

Expert 

 

7 S.J Aayesha  Alumni 
 

8 P. Vineetha Student 
 



Board of Studies Meeting-1 on 17-10-2025 

DEPARTMENT OF COMPUTER SCIENCE 

List of Paper Setters  

S No 
Name of the Paper Setter 

with Designation 
Papers Qualification College - City 

1 Prof. M. Humera Khanam 

Professor in Computer Science 

Department 

ALL Ph.D. Dept of CSE, SVU College of 
Engineering, Tirupathi,  
SV University 

2 Dr. G. Vijay Kumar 

Lecturer in Computer Science 

ALL Ph.D. Dept of Computer Science, 
Tanuku, W.G. Dt,  
AKN University 

3 Manoj Prabhakar Darsi 

Lecturer in Computer Science 

ALL M.Tech  
(Ph.D) 

Dept of Computer Science, 
Nellore,  
Vikram Simhapuri University, 

4 Dr. G. Dayanandam  

Lecturer in Computer Science 

ALL Ph.D. Dept of Computer Science, 
Kodur (RS), Annamayya Dt, 
Yogi Vemana University 

5 Sri. Shaik Munwar 

Lecturer in Computer Science 

ALL M.Tech Dept of Computer Science, 
Vedurukuppam, SV University 

6 Sri. Ismail 

Lecturer in Computer Science 

ALL M.Tech Dept of Computer Science, 
Vedurukuppam, SV University 

7 Sri. T Subramanyam 

Lecturer in Computer Science 

ALL M.Tech Dept of Computer Science, 
Vayalpad, SV University 

8 Smt. A. Sumathi 

Lecturer in Computer Science 

ALL M.Tech Dept of Computer Science, 
Srikalahasti, SV University 

9 Smt. G. Satya Suneetha  

Lecturer in Computer Applications 

ALL M.Tech Dept of Computer Applications, 
Kovvur, E.G. Dt,  
AKN University 

10 Sri. E. Murali Mohan Reddy 

Lecturer in Computer Applications 

ALL MCA Dept of Computer Applications, 
Puttur, SV University 

11 Dr.  A. Ravi Prasad 

Lecturer in Computer Applications 

ALL Ph.D. Dept of Computer Applications, 
Srikalahasti, SV University 

12 Dr. A. Sri Lakshmi 

Lecturer in Computer Applications 

ALL Ph.D. Dept of Computer Applications, 
Nagiri, Autonomous 

13 Sri. Y Srinivasulu 

Lecturer in Computer Applications 

ALL M.Tech Dept of Computer Applications, 
Vedurukuppam, SV University 

14 Smt. B. Durga Anuja 

Lecturer in Computer Applications 

ALL M.Tech Dept of Computer Applications, 
Srikalahasti, SV University 

15 Dr. S. Saravana 

Lecturer in Computer Applications 

ALL Ph.D. Dept of Computer Applications, 
PVKN(A), Chittoor 

16 Sri. T Narendra Babu 
Lecturer in Computer Applications 

ALL M.Tech Dept of Computer Applications, 
Vedurukuppam, SV University 

 
 



Board of Studies Meeting-1 on 17-10-2025 

DEPARTMENT OF COMPUTER SCIENCE 

List of Paper Examiners 

 

S No 
Name of the Examiner  

with Designation 
Papers Qualification College - City 

1 Prof. M. Humera Khanam 

Professor in Computer Science 

Department 

ALL Ph.D. Dept of CSE, SVU College of 
Engineering, Tirupathi,  
SV University 

2 Sri. Shaik Munwar 

Lecturer in Computer Science 

ALL M.Tech Dept of Computer Science, 
Vedurukuppam, SV University 

3 Sri. Ismail 

Lecturer in Computer Science 

ALL M.Tech Dept of Computer Science, 
Vedurukuppam, SV University 

4 Sri. T Subramanyam 

Lecturer in Computer Science 

ALL M.Tech Dept of Computer Science, 
Vayalpad, SV University 

5 Smt. A. Sumathi 

Lecturer in Computer Science 

ALL M.Tech Dept of Computer Science, 
Srikalahasti, SV University 

6 Sri. E. Murali Mohan Reddy 

Lecturer in Computer Applications 

ALL MCA Dept of Computer Applications, 
Puttur, SV University 

7 Dr.  A. Ravi Prasad 

Lecturer in Computer Applications 

ALL Ph.D. Dept of Computer Applications, 
Srikalahasti, SV University 

8 Dr. A. Sri Lakshmi 

Lecturer in Computer Applications 

ALL Ph.D. Dept of Computer Applications, 
Nagiri, Autonomous 

9 Sri. Y Srinivasulu 

Lecturer in Computer Applications 

ALL M.Tech Dept of Computer Applications, 
Vedurukuppam, SV University 

10 Smt. B. Durga Anuja 

Lecturer in Computer Applications 

ALL M.Tech Dept of Computer Applications, 
Srikalahasti, SV University 

11 Dr. S. Saravana 

Lecturer in Computer Applications 

ALL Ph.D. Dept of Computer Applications, 
PVKN(A), Chittoor 

12 Sri. T Narendra Babu 
Lecturer in Computer Applications 

ALL M.Tech Dept of Computer Applications, 
Vedurukuppam, SV University 

 
 
 

 

(Smt. Y Jnapika) 

      CHAIRPERSON BOARD OF STUDIES 



 

DEPARTMENT OF COMPUTER SCIENCE 

 

SCHEME OF EVALUATION 
MODEL OF SEMESTER END EXAMINATION QUESTION PAPER 

(THEORY) 

(As Approved in the BOS meeting held on 17-10-2025) 

EVALUATION SCHEME 

Standard Operating Procedure for Continuous Internal Assessment (Internal Marks – 30). The Internal 

marks in all the courses/subjects will be awarded based on continuous internal assessment made during the 

semester concerned. For each Courses/subject 30 marks are allotted for internal assessment and 70 marks 

are allotted for the End Semester Examination. 

Continuous Internal Evaluation (CIA): 

It has been decided to introduce Continuous Internal assessment marks for a total of 60 marks, which are 

to be distributed as follows: 

S.No. Component Distribution of Marks 

1 CIE I (after completion of 50% of syllabus) 20 

2 CIE II (Online Exam) 20 

3 ATTENDANCE Above 95% 5  

 

 

 

 

 

 

5 

91% to 95% 4 

86% to 90% 3 

81% to 85% 2 

75% to 80% 1 

Below 75% 0 

Pedagogical Strategies  

4 Assignment 5 

5 Participation or Paper Presentation in Student 

Seminars/Workshops/Group Discussions/ Quiz/ Student Study 

Project/Field Visit/Survey 

5 

6 Swatch Bharat (Clean & Green) 5 

TOTAL 60 

*The total 60 Marks is scaled down to 30 Marks*



Component I: CIE I & CIE II (20+20 = 40 Marks) 

 

Two Internal Examinations, out of which one is Mandatorily Online examination, for each Course shall 

be conducted for assessment. These examinations will be conducted during August/September (CIE –I) 

and January/February (CIE-II). CIE-I carries 20 marks and CIE-II carries 20 marks. CIE- I will be 

conducted after completion of 50% of syllabus. The second internal examination, i.e., CIE – II, which 

will cover the remaining second half of the syllabus. The sum of both the CIEs will be considered for 

awarding marks for CIA. 

Suggestive Question Paper Pattern for CIE I & CIE II (Based on Blooms Taxonomy): 

Though the faculty concerned is empowered to adopt their own pattern for question paper, a general and 

suggestive model for question paper is given below based on Blooms Taxonomy. 

 

Q No Learning Objective Marks 

1 Memory based (Remember) 3 

2 Understand (Comprehension) 4 

3 Application 4 

4 Analysis 3 

5 Evaluation 3 

6 Creativity 3 

 TOTAL 20 marks 

 

The active verbs used to frame the question based on Blooms Taxonomy is given below for the 

convenience. 

\ 



Important Note: 

Students who absent themselves from any CIE will lose the marks for the respective test. However, if a 

student is not able to write the CIE I / II because of his/her participation in an important event related to 

NSS/NCC or Games/Sports representing the College/University/health grounds, the student has to get 

the prior permission of the Principal through the proper channel and submit the same to the Office of the 

Controller of Examinations. Deadline is 7 days after the CIE. Applications submitted after the deadline 

will not be considered for the retest. 

 

Component III: Attendance (5 Marks) 

Attendance mark will be awarded to the students based on their attendance percentage on a particular 

course. Faculty of each course has to award the attendance mark based on their subject attendance. 

The marks split-up is given below 
 

 

Above 95% 5 

91% to 95% 4 

86% to 90% 3 

81% to 85% 2 

75% to 80% 1 

Below 75% 0 

 

 

Component IV: Assignment (5 Marks) 

One Assignment for each course must be submitted by a student in each semester. The marks allotted 

to this component will be awarded based on the performance of the student. The assignment topic may 

be assigned either individually or group. Assignment should be submitted by the student in the first 

half of the semester. Also maximum of 7 days should be given to students to submit the assignment. 

Assignments should be evaluated by the faculty concerned and the same to be verified by the student. 

The assignment should be kept in department for the Academic Audit by IQAC and also for external 

academic audit conducted by office of Commissionerate of Collegiate Education. The marks should 

be awarded by the faculty. 

 

Component V (Pedagogical Strategies): 

Participation /Paper Presentation in Student Seminars/Workshops/Group Discussions/ Quiz/ Student 

Study Project/Field Visit/Survey (5 Marks) 

For this component, the marks will be provided to student, if he/she participate/win in the external 

college technical events. To score marks, the student has to participate / present papers related to 

subject in the technical events organized in the other colleges/other departments in the college. 



 

 Participation Second Prize First Prize / 

Best Paper 

Workshop / Seminar / Technical Symposium 2 3 5 

National / International Conference 3 4 5 

 

In case of Classroom seminar, one seminar for each course must be presented by a student in each 

semester. Each student should be given individual topic for seminar; the student has to submit the 

seminar topic as assignment and the same will be presented minimum of 10 minutes in the class 

through ICT. The seminar presented by the student should be evaluated by the subject faculty and 

based on the performance of the presentation, the marks will be awarded. 

 

Similarly, reports on field visits, educational tours, study projects in prescribed format will be 

considered for awarding marks in this component. 

For a student who has not participated in any events in that semester, the student will be awarded “0” 

for this component. If a student participates more than one event and win prize, the best would be 

considered for the subject. 

 

In case of Quiz, offline/online quiz, it should be conducted after the CIE II and well before the SEE. 

Faculty concerned has to announce the schedule for the quiz and conduct the quiz.  

 

Semester End Examinations (SEE) 

 

The question paper is of 2 ½ duration for 70 marks. The suggestive question paper model is given that 

may be used for framing the question. This kind of question paper will be helpful in CO-PO Mapping 

and thereby graduate attributes. 

 



 
Curriculum 2025-26            Version: 1.0 

 
 

DEPARTMENT OF COMPUTER SCIENCE 

 
SCHEME OF VALUATION FOR PRACTICAL EXAMINATIONS 

 

(As Approved in the BOS meeting held on 17-10-2025 for 2025-2026) 

 

S.No. Description Marks 

1 Procedure Explanation with Coding (including Algorithm & 
Flowchart if any) 

15 

2 Execution of Program 10 

3 VIVA VOCE 10 

4 RECORD  15 

  **Total Internal Marks** 50 

5 EXTERNAL PRACTICAL EXAM 
   (At the end of II, IV& VI Semester) 

50 

6 EXTERNAL PRACTICAL EXAM 
(At the end of I, III & V Semester) 

50 

 GRAND TOTAL 100 

 
 

** Award of marks for number of practicals recorded in the Record. 

 

10 Practicals and Above 10 

8 Practicals 8 

6 Practicals 6 

5 Practicals 5 

Less than 5 0 

 

 
 

 

 
 

 

 

 
 

 

 
 

 



 

 

B.Sc. (Honors) Computer Science 
 

 

 
After completion of the program, the student is able to 

 

PSO1: Problem Solving Proficiency: Proficiently analyze intricate problems, identify 

requirements, and implement efficient algorithms using appropriate programming languages. 

PSO2: Expert Software Development: Expertly design software, architect systems, and develop 

solutions with an emphasis on scalability, user experience, and best practices. 

PSO3: Specialized Knowledge Application: Apply specialized knowledge in areas such as AI, 

data science, cyber security, contributing to practical problem-solving and innovative solutions. 

PSO4: Effective Communication and Collaboration: Communicate technical concepts 

effectively and collaborate proficiently within multidisciplinary teams, demonstrating leadership 

and teamwork skills. 

 

 

 

 

 

 

 

 

 

 

Program Specific Outcomes 



B.Sc. (Honors) Computer Science 
 

 

 

 

Sl. No. Program Outcomes (POs) -A student will be able to: 

PO1: Learn the mathematics, statistics and computer science fundamentals to find the 

optimum solution of complex Computer Science problems. 

PO2: Identify, formulate, research literature, and analyse complex scientific problems 

using principles of mathematics, statistics and applied computer science 

PO3: Develop the skills to present ideas effectively and efficiently as a member and as a 

leader. 

PO4: Create, Solve and apply tools of programming, networking, database, Web design, 

AI and modern technology for solutions to significant problems. 

PO5: Design computer-based solutions for various technical problems. 

PO6: Ensure professional development growth through contextual, reflective and lifelong 

learning. 

PO7: Demonstrate knowledge, Design, and implement solutions to significant 

computational problems. 

PO8: Use research-based knowledge and methods design of experiments, analysis and 

interpretation of data, and synthesis of the information to provide valid conclusions. 

PO9: Apply professional ethics, responsibilities and norms of the scientific practice 

PO10: Understand the impact of the software engineering solutions in social and 

environmental contexts, and demonstrate the knowledge and need for development. 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

Programme Outcomes 



 
 

 

R25 CIRRICULUM FRAMEWORK 
 

 

 
 
 

 

 
 

 



 
R25 COURSE STRUCTURE

 



 



 
 
 
 

SEMESTER-I 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 



 

 
 

Course Code Title of the Course L S/M P C 

     25BCS101T Computer Fundamentals and Office 

Automation 

3   3 

Prerequisites   Basic Computer Knowledge 

 

COURSE OBJECTIVES 

1 
To understand foundational computing concepts including number systems, 

evolution of computers, and architectural components. 

2 To explore basic computer organization and network components. 

3 
To demonstrate proficiency in word processing, presentation tools, and spreadsheet 

operations. 

4 To apply modern tools for analyzing and visualizing data efficiently. 

 

 

COURSE OUTCOMES 
 

BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Convert between binary, decimal, octal, and hexadecimal systems 

Understanding 

CO2 
Demonstrate blocks of a computer and fundamental networking devices. 

Understanding  

CO3 
Prepare visually appealing presentations 

Applying 

CO4 
Produce accurate summaries and visualizations. 

Applying 

CO5 
Analyze, organize, and represent data effectively Analyzing 

 

 

 

 

 

 

 



 

Syllabus 
 

COURSE CONTENT 

UNIT I 

Number Systems: Binary, Decimal, Octal, Hexadecimal; Conversions between number 

systems. 

Block Diagram of a Computer: Input Unit, Central Processing Unit, Memory Unit, Output 

Unit. 

Generations of Computers: First to Fifth Generation – Technologies, Characteristics, 

Examples.  

Activity: Create a digital poster or infographic comparing number systems and illustrating the 

timeline of computer generations with key innovations. 

Evaluation Method: Rubric-based assessment of the poster presentation on a 10-point scale 

based on Visual organization and creativity. 

UNIT II 

Computer Organization: Functional components: Input/Output devices, Storage types, 

Memory Hierarchy. 

Types of Computers: Micro, Mini, Mainframe, and Supercomputers. 

Networking Fundamentals: Definition, need for networks, types (LAN, WAN, MAN), 

topology (Star, Ring, Bus). 

Internet Basics: IP Address, Domain Name, Web Browser, Email, WWW. 

Activity: Design a concept map showing the internal architecture of a computer and types of 

networks (LAN, WAN, MAN), including devices and topologies. 

Evaluation Method: Checklist-based peer review and instructor validation based on 

correctness and completeness, structure of the map. 

UNIT III 

Word Processing Basics: Using MS Word/Google Docs – formatting, styles, tables, mail 

merge.  

Presentation Tools: Using PowerPoint/Google Slides – slide design, animations, transitions. 

Applications: Creating resumes, reports, brochures, and presentations.  

Keyboard Shortcuts 

Activity: Prepare a formal report (e.g., project proposal) in a word processor and present it 

using a slide deck with transitions, embedded media, and design elements. 

Evaluation Method: Performance-based evaluation using a 10-point scoring scale based on 

presentation and communication skills 

UNIT IV 

Spreadsheet Concepts: Understanding rows, columns, cells in tools like MS Excel/Google 

Sheets, Cell referencing- Relative, Absolute, Mixed. 

Functions and Formulae: SUM, AVERAGE, IF, COUNT. 

Charts and Graphs: Creating visual representations. 

Data Handling: Sorting, filtering 

Text Functions: LEFT, RIGHT, MID, LEN, TRIM, CONCAT, TEXTJOIN 

Advanced Functions: Logical: IF, AND, OR, IFERROR, Lookup: VLOOKUP, HLOOKUP, 

INDEX, MATCH 



Activity: Analyze a dataset (e.g., student scores or sales data) using spreadsheet software. 

Apply formulas (SUM, AVERAGE, IF, VLOOKUP) and create relevant charts. 

Evaluation Method: Practical test with a rubric: Correct use of Formulae and accuracy of data 

summaries 

UNIT V 

Conditional Formatting: Custom rules, Color scales, Icon sets, Data bars  

Data Analysis Tools: Pivot Tables and Pivot Charts, Data Validation (Drop-downs, Input 

Messages, Error Alerts), What-If Analysis: Goal Seek, Data Tables 

Charts and Dashboards: Creating Interactive Dashboards, Using slicers with Pivot Tables, 

Combo Charts and Sparklines. 

Activity: Prepare an interactive dashboard for a given data set using EXCEL. 

Evaluation Method: Evaluation of the dashboard on a 10-point scoring scale based on 

presentation and communication skills 

 

TEXT BOOKS 

1. Thareja, R. (Second Edition). Fundamentals of Computers. Oxford University Press. 

2. Rajaraman, V. (n.d.). Fundamentals of Computers. PHI Learning. 

3. Norton, P. (2017). Introduction to Computers (7th ed.). McGraw Hill Education. 

4. 

Nordell, R., Stewart, K., Easton, A., Graves, P. R., & Triad Interactive, Inc. (2022). Microsoft 

Office 365: In Practice (1st ed.). New York: McGraw Hill Education. 

REFERENCE BOOKS 

1. Alexander, M., & Kusleika, R. (2022). Microsoft Excel 365 Bible (2nd ed.). Wiley. 

2. Lowe, D. (2021). Networking All-in-One for Dummies (8th ed.). Wiley. 

WEB RESOURCES 

1. Microsoft Official Docs and Training: https://learn.microsoft.com 

2. Google Workspace Learning Center: https://support.google.com/a/users/ 

 

 
  



 

 CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 2 2 0 0 1 0 0 0 0 0 0 1 0 0 

CO2 2 2 1 0 2 1 0 0 0 0 0 1 0 0 

CO3 2 3 2 1 2 1 0 1 0 0 0 1 1 1 

CO4 3 2 1 1 2 1 0 2 0 0 0 1 1 1 

CO5 3 3 2 1 2 1 1 2 1 0 0 1 2 0 

 
 

Model Blue print for the question paper setter 
 

 

S.No. UNIT- Essay 10M Short 4 M Weightage 

1 I 2 2 20% 

2 II 2 2 20% 

3 III 2 2 20% 

4 IV 2 2 20% 

5 V 2 2 20% 

  100 40 100% 



 
I B.Sc. (Hons) Computer Science Semester-I 

 

Recommended Format of Question Paper for all Courses 
Time: 3 Hours                                                                                                 Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

  OR 

           B) From Contents of Unit –V 

***** 



 

Computer Fundamentals and Office Automation 
MODEL QUESTION PAPER (W.E.F 2025-2026) 

  Time: 2 ½ Hrs. Max Marks: 70 
Q. No Question Marks BL CO PO PI 

SECTION – B 

Answer any Five of the Following 5 X 4 = 20M  

1 Explain about Evolution of Computers.  4M 2 1   

2 Write down the steps to convert a decimal number to binary 

number with an example? 
4M 2 1   

3 Explain about various kinds of computer memories. 4M 2 2   

4 Discuss about different types of Network Topologies. 4M 2 2   

5   Summarize different types of text formatting in MS-Word? 4M 2 3   

6 Explain about various Keyboard shortcuts? 4M 2 3   

7 Show the steps to insert rows and columns in MS-Excel? 4M 3 4   

8 Explain about different types of cell references in MS-Excel? 4M 2 4   

9  Define Data validation? Explain about Data validation using     

Drop-downs. 
4M 2 5   

10 Explain about Combo Charts. 4M 4 5   

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

SECTION – B 

Answer All Questions  5 X 10 = 50M   

11 a). Explain the generations of computers and their characteristics. 

(OR) 

b). Explain the characteristics and applications of computers. 

c). Describe the components of a computer system in detail. 

10M    2 1   

  

5M 

 

  2 

 

1 

 5M 1 1 

12 
a). Discuss about Input and Output devices in the computer. 

(OR) 

b). Summarize different types of network topologies? 

  10M   2 2   

 
10M 2 2 

13 a). Illustrate the concept of Mail Merge in MS-Word? 

(OR) 

c). What is MS Power Point?  Explain about the creation of presentation 

using MS power Point. 

10M 3 3   

  

   

 10M 2 3 

14 a). Explain different types of Text functions in MS-Excel? 

(OR) 

b). Explain different types of charts used in MS-Excel? 

10M 2 4   

 10M   4   4 

15 a). What is What-If Analysis? Explain about primary tools for What-If 

Analysis in Excel? 

(OR) 

b). Write short notes on: 

      a) Pivot Tables 

      b) Pivot Charts  

10M 

 

 

    

5M 

5M 

  2 

 

 

2 

2  

 

5 

 

 

 

5 

5 

  

 

 

 
 

*****



 
Course Code Title of the Course L S/M P C 

25BCS101P Fundamentals of Information Technology & Office 

Automation  

  2 1 

Prerequisites Basic Computer Knowledge 

  

Objectives:                                                                                                                                             

 

1. Learn basics of computer hardware. 

2. Learn how to work with MS-Office tools. 

  

List of Experiments: 

  

1. Demonstration of Assembling and Dissembling of Computer Systems.  

2. Identify and prepare notes on the type of Network topology of your institution.  

3. Prepare your resume in Word.  

4. Using Word, write a letter to your higher official seeking 10-days leave.  

5. Prepare a presentation that contains text, audio and video.  

6. Using a spreadsheet, prepare your class Time Table.  

7. Using a Spreadsheet, calculate the Gross and Net salary of employees (Min 5) considering all the 

allowances.  

8. Generate the class-wise and subject-wise results for a class of 20 students. Also generate the highest and 

lowest marks in each subject.  

9. Using IF, AND, OR, and IFERROR to Automate Grade Evaluation.  

a. Create a table of student scores in different subjects.  

b. Use IF to assign grades (A/B/C/Fail).  

c. Use IFERROR to handle missing scores or invalid data.  

10. Employee Database Search Using VLOOKUP, HLOOKUP, XLOOKUP, INDEX, and  

MATCH  

a. Create a database of employees (Name, ID, Department, Salary).  

b. Implement VLOOKUP to search by employee ID.  

c. Use HLOOKUP to extract department heads by role.  

d. Use INDEX + MATCH as an alternative to VLOOKUP.  

11. Sales Report Analysis Using Pivot Tables and Charts  

a. Use a dataset of product sales (Product, Region, Date, Quantity, Revenue).  

b. Create Pivot Tables to summarize data by region/product.  

c. Insert Pivot Charts for visual analysis (e.g., bar, line).  

d. Add slicers to make the dashboard interactive.  

 

 



12. Designing a Data Entry Form with Drop-downs and Input Rules  

a. Create a student registration form.  

b. Add drop-down lists for course selection using Data Validation.  

c. Add input messages to guide users.  

d. Add error alerts for wrong entries.  

13. Monthly Budget Planning using Goal Seek and Scenario Manager  

a. Create a simple personal budget (income, expenses, savings).  

b. Use Goal Seek to determine income needed to save a desired amount.  

c. Use Scenario Manager to compare different budgeting scenarios (best/ worst/  

realistic case).  

d. Create a one-variable Data Table to analyze how different expenses affect savings.  

14. Dashboard Creation Using Combo Charts, Sparklines & Slicers  

a. Use existing sales or attendance data.  

b. Insert combo charts (e.g., column + line).  

c. Add sparklines to show trends.  

d. Use slicers with Pivot Tables to control dashboard elements.  

e. Finalize and format for interactivity. 

 

 

 

 

 

 

 

 

 

  



 
 

Course Code Title of the Course L S/M P C 

       25BCS102T   Problem Solving using C 3   3 

Prerequisites Basic Computer Knowledge 

 

COURSE OBJECTIVES 

1 

To impart adequate knowledge on the need of programming languages and problem-solving 

techniques. 

2 To develop programming skills using the fundamentals of C Language. 

3 To enable effective usage of arrays, structures, functions, pointers and dynamic memory allocation. 

4 To make use of file handling functions in programming. 

 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Identify the fundamentals of C Programming for Problem solving. 

Knowledge 

CO2 
Demonstrate the appropriate Decision statement and Loops for a given 

Problem. 
Understanding 

CO3 
Make use of Arrays and Strings to solve the problems in C. 

Applying 

CO4 
Apply the concepts of Functions and Pointers in Problem solving. 

Applying 

CO5 
Discover solutions for problems using Structures, Unions and Files. Applying 

 

 

 

 

 

 

 

 

 

 

 

 



Syllabus 
 

COURSE CONTENT 

UNIT I 

Introduction to computer and programming: Introduction, Concepts of Hardware and 

software, Types of software, Compiler and interpreter, Concepts of Machine level, 

Assembly level and high-level programming, Flowcharts and Algorithms 

Fundamentals of C: History of C, Features of C, C Tokens-variables and keywords and 

identifiers, constants and Data types, Rules for constructing variable names, Operators, 

Structure of C program, Input /output statements in C-Formatted and Unformatted I/O. 

Activity: Quiz on computer hardware and software concepts  

Evaluation Method: Objective-based quiz assessing knowledge and understanding 

UNIT II 

Control statements: Decision making statements: if, if else, else if ladder, switch 

statements.  

Loop control statements: while loop, for loop and do-while loop. Jump Control statements: 

break, continue and goto. 

Activity: Problem-solving using Decision-Making Statements  

Evaluation Method: Correctness of decision-making logic 

UNIT III 

Derived data types in C: Arrays: One Dimensional arrays - Declaration, Initialization 

and Memory representation; Two Dimensional arrays -Declaration, Initialization and 

Memory representation. 

Strings: Declaring & Initializing string variables; String handling functions, Character 

handling functions. 

Activity: Pair Programming Exercise on Functions  

Evaluation Method: Collaboration and Code Quality 

UNIT IV 

Functions: Function Prototype, definition and calling. Return statement. Nesting of 

functions. Categories of functions. Recursion, Parameter Passing by address & by value. 

Local and Global variables. Storage classes: automatic, external, static and register. 

Pointers: Pointer data type, Pointer declaration, initialization, accessing values using 

pointers. Pointer arithmetic. Pointers and arrays, pointers and functions 

Dynamic Memory Management: Introduction, Functions-malloc, calloc, realloc, free 

Activity: Pair Programming Exercise on Functions  

Evaluation Method: Collaboration and Code Quality 

UNIT V 

Structures:  Basics of structure, structure members, accessing structure members, nested 

structures, array of structures, structure and functions, structures and pointers.  

Unions - Union definition; difference between Structures and Unions.  

Files operations: Working with text files - modes: opening, reading, writing and closing text 

files. 



Activity: Structured Programming Assignment  

Evaluation Method: Appropriate use of structures and nested structures 

 

 

TEXT BOOKS 

1. Programming in C, Reema Thareja, 2nd Edition, Oxford University Press. 

2. The C programming Language, Dennis Richie and Brian Kernighan, Pearson Education 

REFERENCE BOOKS 

1. Programming in C – Ashok N. Kamthane, Amit Ashok Kamthane, 3rd Edition, Pearson. 

2. C Programming-A Problem Solving Approach, Forouzan, Gilberg, Cengage. 

3. Programming in C (A Practical Approach) – Ajay Mittal, First Edition, Pearson. 

WEB RESOURCES 

1. http://nptel.ac.in/courses/106104128/  

2. http://students.iitk.ac.in/programmingclub/course/#notes  

3. http://c-faq.com/~scs/cclass/cclass.html  

4. http://www.youtube.com/watch?v=b00HsZvg-V0&feature=relmfu 

5. 

http://ocw.mit.edu/courses/electrical-engineering-and-computer-science/6-087-practical-programming-in-c-

january-iap-2010/ 

 

 

 

 

 

 

  

http://nptel.ac.in/courses/106104128/
http://students.iitk.ac.in/programmingclub/course/#notes
http://c-faq.com/~scs/cclass/cclass.html
http://www.youtube.com/watch?v=b00HsZvg-V0&feature=relmfu
http://ocw.mit.edu/courses/electrical-engineering-and-computer-science/6-087-practical-programming-in-c-january-iap-2010/
http://ocw.mit.edu/courses/electrical-engineering-and-computer-science/6-087-practical-programming-in-c-january-iap-2010/


 CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 2 2 0 1 1 1 0 0 0 0 1 1 1 0 

CO2 2 3 0 1 1 1 0 0 0 0 1 1 1 0 

CO3 2 3 0 1 1    1 1 0 0 0 2 1 1 0 

CO4 2 3 0 2 1 1 1 1 0 0 2 2 1 0 

CO5 2 3 0 2 1 1 1 0 0 0 2 2 1 0 

 

Model Blue print for the question paper setter 
 

 

Sl. No. UNIT- Essay 10M Short 4 M Weightage 

1 I 2 2 20% 

2 II 2 2 20% 

3 III 2 2 20% 

4 IV 2 2 20% 

5 V 2 2 20% 

  100 40 100% 



 
I B.Sc. (Hons) Computer Science Semester-I 

 

Recommended Format of Question Paper for all Courses 
Time: 3 Hours                                                                                                 Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

       OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

      OR 

     B) From Contents of Unit –V 

***** 



 

Problem Solving using C 

MODEL QUESTION PAPER (W.E.F 2025-2026) 

Time: 2 ½ Hrs. Max Marks: 70 
Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1 Define software? List different types of software. 4M 1 1   

2 Discuss about formatted and unformatted I/O. 4M 2 1   

3 Construct a program to find given number is even or odd. 4M 3 2   

4 Distinguish break and continue statements in C. 4M 2 2   

5 Explain two dimensional arrays in C. 4M 2 3   

6 Construct a C program that reads string input from the 
user and display its length. 

4M 3 3   

7 Explain about recursion. 4M 2 4   

8 Interpret the concept of pointers and functions with an 
example. 

4M 2 4   

9 Compare Structures and union in C. 4M 2 5   

10 Define Union? Explain about accessing union members 4M 2 5   

 

 

 

 

 

 

 

 

 

 

 

 

 

 



SECTION – B 

Answer All Questions  5 X 10 = 50 M   

11 a) Explain the basic block diagram of a computer system 

and explain the functions of its various components. 

(OR) 

b) Define flow chart? Explain various symbols in Flow 

chart. 

c) Construct a C program to compute simple interest. 

10M 2 1   

  

5M 

 

2 

 

1 

 
    5M 3 1 

12 a) Illustrate Iterative statements in C with syntax and 

examples. 

(OR) 

b) Explain Decision making statements in C 

Programming with example. 

10 M 3 2   

 
 

10M 

   

    2 

 

2 

13 a) Describe the process of declaring and initializing a 

two-dimensional array in C programming. 

b) Explain different string manipulation library functions 

with example. 

(OR) 

b) Construct a C program to perform multiplication 

of two matrices. 

5M 1 3   

 
5M 2 3 

 
 

10M 
 

3 
 

3 

14 a) Explain auto, extern, static, register storage 

classes in C with syntax. 

(OR) 

b) Define function? Discuss about various categories of 

functions. Illustrate with example. 

10M 2 4   

 
 

10M 
 

2 
 

4 

 15 a) Describe about Dynamic memory allocation 

mechanism in C with syntax and example. 

(OR) 

 b) Explain Structures in C programming with example.  

10M 

 

 

  10M 

    2 

 

 

    2 

5 

 

 

    5 

  

 

**All the Best**



 
 

Course Code Title of the Course L S/M P C 

25BCS102P Problem Solving using C Lab   2 1 

Prerequisites Basic Computer Knowledge 

 

Objectives:                                                                                                                                             

 

1. Learn how to solve common types of computing problems. 

2. Learn to map problems to programming features of C. 

 

List of Experiments/Syllabus: 

    
1. Write a program to check whether the given number is Armstrong or not.  

2. Write a program to find the sum of individual digits of a positive integer.  

3. Write a program to generate the first n terms of the Fibonacci sequence. 

4. Write a program to find both the largest and smallest number in a list of integer values  

5. Write a program to demonstrate change in parameter values while swapping two integer variables using 

Call by Value & Call by Address  

6. Write a program to perform various string operations.  

7. Write a program to search an element in a given list of values.  

8. Write a program that uses functions to add two matrices.  

9. Write a program to calculate factorial of given integer value using recursive functions  

10. Write a program for multiplication of two N X N matrices.  

11. Write a program to sort a given list of integers in ascending order.  

12. Write a program to calculate the salaries of all employees using Employee (ID, Name, Designation, 

Basic Pay, DA, HRA, Gross Salary, Deduction, Net Salary) structure.  

a. DA is 30 % of Basic Pay  

b. HRA is 15% of Basic Pay  

c. Deduction is 10% of (Basic Pay + DA)  

d. Gross Salary = Basic Pay + DA+ HRA  

e. Net Salary = Gross Salary - Deduction  

13. Write a program to read / write the data from / to a file.  

14. Write a program to reverse the contents of a file and store in another file.  
 

Reference Books:                                                      

1. Henry Mullish & Huubert L. Cooper: The Spirit of C An Introduction to 

modern Programming, Jaico Pub. House,1996. 

2. Y Kanithkar, let us C BPB, 13th Edition-2013, ISBN:978-8183332430,656 pages. 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SEMESTER-II 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

Course Code Title of the Course L S/M P C 

25BCS203T  DATA STRUCTURES USING C 3   3 

Prerequisites C Programming 

 

COURSE OBJECTIVES 

1 

To assess how the choice of data structures and algorithm design methods impacts the   performance 

of programs. 

2 To choose the appropriate data structure and algorithm design method for a specified application. 

3 

To solve problems using data structures such as linear lists, stacks, queues, trees and graphs and 

writing programs for these solutions.  

 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 Understand various data structures and their applications 
Understand 

CO2 Apply concepts of linked lists. 
Applying 

CO3 Implement algorithms for stacks, queues.  
Applying 

CO4 Implement sorting and searching algorithms.  
Applying 

CO5 Illustrate algorithms on Trees and Graphs.  Applying 

 

 

 

 

 
 

 

 

 

 

 

 

 

 



Syllabus 
 

COURSE CONTENT 

UNIT I 

Basic Concepts:  Algorithm: Definition and characteristics, Complexity analysis: Space 

Complexity, Time Complexity, Asymptotic Notations-Big -O Notations.   

Introduction to Data structures: Definition, Types of Data structures, Introduction to 

Linked Lists, Representation of linked lists in Memory, Comparison between Linked 

List and Array. 

Activity: Algorithm analysis exercises  

Evaluation Method: Programming Assignment and Correctness 

UNIT II 

Searching: Linear or Sequential Search, Binary Search 

Sorting: Bubble Sort, Insertion Sort, Selection Sort, Quick Sort. 

Activity: Sorting algorithm analysis and comparison activities 

Evaluation Method: Performance analysis and presentation. 

UNIT III 

Linked Lists: 

Types of Linked Lists - Singly Linked list, Doubly Linked list, Circularly Singly Linked 

list, Circularly Doubly Linked list; Implementation of Single Linked Lst ADT: Creating 

a List, traversing a linked list, searching in linked list, Insertion and deletion into linked 

list (At first Node, Specified Position, Last node). 

Activity: Presentations on real-life applications of linked lists  

Evaluation Method: Presentation skills or reports 

UNIT IV 

Stacks: Introduction to stack, Implementation of stacks using array and Linked List, 

Application of stacks - Polish Notations - Converting Infix to Post Fix Notation - 

Evaluation of Post Fix Notation.  

Queues: Introduction to Queue, Implementation of Queues using array and Linked List, 

Application of Queues Types of Queues- Circular Queues, De-queues, Priority Queue. 

Activity: Role-playing activities for stack operations  

Evaluation Method: Problem-solving skills, communication and collaboration 

abilities 

UNIT V 

Trees: Tree Terminology, Binary Tree Representation, Traversal techniques, Binary 

Search Tree- Definition, Operations on a Binary Search Tree: Creation, Search, Insertion 

& deletion.  

Graphs: Introduction to Graphs, Terminology, Representation (Adjacency Matrix, 

Adjacency List), Traversal of Graphs (DFS, BFS), Applications of Graphs-Finding 

Shortest Path using Dijkstra’s algorithm. 

Activity: Case Study on Applications of Graphs  

Evaluation Method: Critical thinking, problem-solving, and presentation skills 

 

 

 



TEXT BOOKS 

1. Data Structures Using C, Reema Thareja, 2nd Edition, Oxford University Press. 

2. Langsam, Augenstein and Tanenbaum, “Data Structures using C”, PHI. 

3. Mark Allen Weiss, “Data Structures and Algorithm Analysis in C”, 2nd Edition, Pearson Education. Ltd. 

REFERENCE BOOKS 

1. 

G.A.V Pai, Data Structures and Algorithms, Concepts, Techniques and Applications, Volume 1,1st Edition, 

Tata McGraw-Hill, 2008.  

2. 

Richard F. Gilberg and Behrouz A. Forouzan, “Data Structures, Pseudo code Approach with C”, 2nd Edition, 

Cengage Learning India Edition, 2007. 

WEB RESOURCES 

1. http://nptel.iitm.ac.in/video.php? subjectId=106105085  

2. http://cds.iisc.ac.in/courses/ds286/  

3. http://www.geeksforgeeks.org/data-structures  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://cds.iisc.ac.in/courses/ds286/
http://www.geeksforgeeks.org/data-structures


 CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 0 1 1 1 1 1 1 0 1 1 1 0 

CO2 3 3 0 1 1 1 1 1 1 0 2 1 0 0 

CO3 2 3 0 1 1 1 1 1 1 0 1 1 0 0 

CO4 2 3 0 1 1 1 1 1 1 0 1 1 0 0 

CO5 3 3 0 2 1 1 2 1 1 0 1 1 1 0 

 

Model Blue print for the question paper setter 
 

Sl. No. UNIT- Essay 10M Short 4 M Weightage 

1 I 2 2 20% 

2 II 2 2 20% 

3 III 2 2 20% 

4 IV 2 2 20% 

5 V 2 2 20% 

  100 40 100% 



 
I B.Sc. (Hons) Computer Science Semester-II 

 

Recommended Format of Question Paper for all Courses 
Time: 3 Hours                                                                                                 Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

        OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

        OR 

     B) From Contents of Unit –V 

***** 



 
DATA STRUCTURES USING C 

MODEL QUESTION PAPER (W.E.F 2025-2026) 

Time: 2 ½ Hrs. Max Marks: 70 
Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1 Write a short note on Asymptotic notation. 4M 2 1   

2 Discuss about space complexity and time complexities 
with examples. 

4M 2 1   

3 Explain about Bubble sort with example. 4M 2 2   

4 Explain about Linear search with example. 4M 2 2   

5 Discuss about insertion at the beginning of a Doubly 
Linked List. 

4M 2 3   

6 Define Circular Linked List with an example 4M 1 3   

7 Explain about applications of stack. 4M 2 4   

8 Define Priority Queue with an example. 4M 1 4   

9 List the Properties of Trees. 4M 1 5   

10 Explain about Graph representation. 4M 2 5   

 

 

 

 

 

 

 

 

 

 

 

 

 

 



SECTION – B 

Answer All Questions  5 X 10 = 50 M   

11 a) Explain about types of data structures with 

examples.  

(OR) 

 

b) Explain about operations of an Array with examples. 

10M 2 1   

   

   

   

10M 

 

 

 

2 

 

 

 

1 

12 
a) Search a given element in the list using binary search: 

25, 56, 98, 14, 73 

(OR) 

 

b) Sort the given elements using Selection Sort: 

25, 56, 98, 14, 73 

10M 3 2   

 
 

 

10M 

 

 

3 

 

 

    2 

13 a) Illustrate Single Linked List and its operations 

(OR) 

b) Explain Circular Linked List with example. 

 

10M 3 3   

  

   10M 

 

2 

 

3 

14 a) Convert the given expression into reverse polish 

notation: (A+B) * (C-D) + E/F 

b)  Evaluate the given expression using Stacks: 

(A+B) * (C-D) + E/F  

(OR) 

c) Explain about Queue data structure and its operations. 

5M 2 4   

  

5M 

 

 

 

 10M 

 

5 

 

 

 

2 

 

4 

 

 

 

4 

15 a) Explain about Binary Tree Traversal algorithms. 

(OR) 

 b) Differentiate Breadth First Search and Depth First 

Search Graph traversals.  

10M 

 

   10M 

    2 

 

    2 

5 

   

    5 

  

 

 
**All the Best**



 
 

Course Code Title of the Course L S/M P C 

     25BCS203P  DATA STRUCTURES USING C   2 1 

Prerequisites C Programming 

 

Objectives:                                                                                                                                             

 

1. To provide hands on experience to implement basic linear and non-linear data structures. This 

course covers implementation of Stack, Queue, List, Sorting techniques, Binary Search Trees. 

 

List of Experiments/Syllabus: 

    
1. Write a program to read ‘N’ numbers of elements into an array and also perform the  

following operation on an array  

a. Add an element at the beginning of an array  

b. Insert an element at given index of array  

c. Update an element using a values and index  

d. Delete an existing element  

2. Write a program to search an item in a given list using the following Searching Algorithms  

a. Linear Search  

b. Binary Search.  

3. Write a program for implementation of the following Sorting Algorithms  

a. Bubble Sort  

b. Insertion Sort  

c. Selection Sort 

d. Quick Sort  

4. Write a program to implement Single Linked List with insertion, deletion and traversal  

operations  

5. Write a program to implement Doubly Linked List with insertion, deletion and traversal  

operations  

6. Write a program to implement the Stack operations using Arrays and Linked Lists.  

7. Write a program to convert a given infix expression to a postfix expression using stacks.  

 



8. Write a program to implement the Queue operations using Arrays and Linked Lists.  

9. Write a program to implement the Circular Queue operations using Arrays.  

10. Write a program for Binary Search Tree Traversals  

 

 

Reference Books:                                                      

1. Data Structures Using C, Reema Thareja, 2nd Edition, Oxford University Press. 

2. Langsam, Augenstein and Tanenbaum, “Data Structures using C”, PHI. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

Course Code Title of the Course L S/M P C 

25BCS204T  DIGITAL LOGIC DESIGN 3   3 

Prerequisites Basics of Computers 

 

COURSE OBJECTIVES 

1 To solve a typical number base conversion and analyze new error coding techniques. 

2 

Theorems and functions of Boolean algebra and behavior of logic gates, Boolean function 

simplification using Karnaugh maps 

3 To understand concepts of combinational circuits and sequential circuits 

 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Classify different number systems and apply to generate various codes. 

Understanding 

CO2 
Paraphrase the concept of Boolean algebra and K-map technique in 

minimization of switching functions. 
Understanding 

CO3 
Implement different types of combinational logic circuits – Adders, 

Subtractors. 
Analyzing 

CO4 
Apply knowledge of combinational logic circuits – Decoders, 

Multiplexers 
Applying 

CO5 

Apply knowledge of Sequential logic for designing flip-flops, registers 

and counters. 
Applying 

 
 

 

 

 

 

 

 

 

 

 

 

 



Syllabus 
 

COURSE CONTENT 

UNIT I 

Number Systems: Conversion of numbers from one radix to another radix, r’s, (r-1)’s 

complements, signed binary numbers, addition and subtraction of unsigned and signed 

numbers, weighted and unweighted codes. 

Activity: JAM (Just a Minute) Session: Explaining Radix Conversion  

Evaluation Method: Communication Skills and Knowledge Presentation 

UNIT II 

Logic Gates and Boolean Algebra: NOT, AND, OR, universal gates, X-OR and X-NOR 

gates, Boolean laws and theorems, complement and dual of a logic function, canonical and 

standard forms, two level realization of logic functions using universal gates, minimizations 

of logic functions (POS and SOP) using Boolean theorems, K-map (up to four variables), 

don’t care conditions. 

Activity: Boolean Algebra Assignment  

Evaluation Method: Assignment Completion and Correctness 

UNIT III 

Combinational Logic Circuits – 1: Design of half adder, full adder, half subtractor, full 

subtractor, ripple adders and subtractors, ripple adder / subtractor. 

Activity: Hands-on Lab Activity: Building Adder and Subtractor Circuits  

Evaluation Method: Lab Performance and Correctness of Circuit Implementation 

UNIT IV 

Combinational Logic Circuits – 2: Design of decoders, encoders, priority encoder, 

multiplexers, demultiplexers, higher order decoders. 

Activity: Group Discussion: Applications of Decoders, Encoders, Multiplexers 

Evaluation Method: Participation and Critical Thinking 

UNIT V 

Sequential Logic Circuits: Classification of sequential circuits, latch and flip-flop, RS- 

latch using NAND and NOR Gates, RS, JK, T and D flip-flops, truth tables and excitation 

tables. 

Registers- shift registers, bidirectional shift registers, universal shift register. 

Activity: Quiz on Flip-Flops and Register-Counter Design  

Evaluation Method: Quiz Performance and Knowledge Retention 

 

 

 



 

TEXT BOOKS 

1. Digital Design, M. Morris Mano, Michael D Ciletti,5th edition, Pearson. 

2. Switching Theory and Logic Design by A. Anand Kumar, PHI, 3rd Edition. 

3. Digital Logic Design, K.C. Rao, Ramana, Pen International Press.    

REFERENCE BOOKS 

1. Fundamentals of Logic Design by Charles H. Roth Jr, Jaico Publishers, 5th Edition 

2. Digital electronics logic and design-Cherry Bhargava, BS Publications, 2019 

3. Modern Digital Electronics by RP Jain, TMH, 4th Edition. 

WEB RESOURCES 

1. https://www.youtube.com/watch?v=4fV47wABBj8  

2. 

Lecture series on Digital Circuits & Systems by Prof. S. Srinivasan, Department of Electrical 

Engineering, IIT Madras. For more details on NPTEL visit http://nptel.iitm.ac.in 

3. https://www.geeksforgeeks.org/digital-logic/digital-electronics-logic-design-tutorials/  

4. https://www.elprocus.com/tutorial-on-sequential-logic-circuits/  

5. http://web.ee.nchu.edu.tw/~cpfan/FY92b-digital/Chapter6.pdf 

6. https://www.electronics-tutorials.ws/combination/comb_1.html  

 

 

 

 

 

 

 

 

 

 

 

 

https://www.youtube.com/watch?v=4fV47wABBj8
http://nptel.iitm.ac.in/
https://www.geeksforgeeks.org/digital-logic/digital-electronics-logic-design-tutorials/
https://www.electronics-tutorials.ws/combination/comb_1.html


 

 CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 0 0 0 1 0 0 0 0 0 0 0 0 0 

CO2 1 0 0 0 1 0 1 0 0 0 0 0 1 0 

CO3 1 1 0 0 1 0 1 1 0 0 1 1 1 0 

CO4 1 1 0 1 1 0 1 1 0 0 1 1 1 0 

CO5 1 1 0 0 1 0 1 1 0 0 1 1 1 0 

 

Model Blue print for the question paper setter 
 

Sl. No. UNIT- Essay 10M Short 4 M Weightage 

1 I 2 2 20% 
2 II 2 2 20% 
3 III 2 2 20% 
4 IV 2 2 20% 
5 V 2 2 20% 

  100 40 100% 



 
I B.Sc. (Hons) Computer Science Semester-II 

 

Recommended Format of Question Paper for all Courses 
Time: 3 Hours                                                                                                 Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

        OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

        OR 

     B) From Contents of Unit –V 

***** 



 
DIGITAL LOGIC DESIGN 

MODEL QUESTION PAPER (W.E.F 2025-2026) 

Time: 2 ½ Hrs. Max Marks: 70 
Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1 Calculate the 10‟s and 9’s complement of the decimal 
number 7324. 

4M 3 1   

2 List different number systems? Give examples for each. 4M 1 1   

3 Write a short note on canonical forms 4M 2 2   

4 Explain about minimizations of logic functions 4M 2 2   

5 Infer the truth table for half Subtractor 4M 2 3   

6 Infer the truth table for full adder 4M 2 3   

7 Write a short note on Demultiplexer. 4M 2 4   

8 Describe the working of an Encoder. 4M 2 4   

9 Explain about shift register. 4M 2 5   

10 Differentiate latches and flip flops 4M 2 5   

 

 

 

 

 

 

 

 

 

 

 

 

 

 



SECTION – B 

Answer All Questions  5 X 10 = 50 M   

11 a) Convert the following numbers    

i) (163.789)10 to Octal number    

ii) (11001101.0101)2 to base-16  

iii) (4567)10 to base 2  

iv) (4D.56)16 to Binary  

b) Subtract (1110)2 from (1010)2 using 2‟s 

complement?  

(OR) 

c) Explain Weighted codes with examples.  

d) Represent the decimal number 3452 in   

        i) BCD            ii) Excess- 3. 

5M 2 1   

   

   

 

 

 

   5M 

 

 

 

 

   5M 

 

   5M 

 

 

 

 

 

2 

 

 

 

 

2 

 

2 

 

 

 

 

 

1 

 

 

 

 

1 

 

1 

12 
a) a) Minimize the following expression in SOP form 

using K-Map             

f(a,b,c,d) = Σm(1,2,3,5,6,7,11,12,13,14,15)  

b) Minimize the following using POS for using K-Map  

          f(x,y,z) = πM(1,2,4,5,7)  

(OR) 

c) Explain basic logic gates: AND, OR, NOT with truth 

tables. 

5M 3 2   

 
5M 

 

 

 

5M 

 3 

 

 

 

     2 

2 

 

 

 

2 

13 a) Explain Half Subtractor and Full subtractor with truth 

tables and schematic diagram. 

(OR) 

b) Discuss about ripple adder/subtractor circuit capable of 

performing both addition and subtraction operations. 

10M 2 3   

  

 

   10M 

 

 

2 

 

 

3 

14 a) Illustrate the operation of 3 to 8 decoder with 

schematic diagram and truth table 

(OR) 

b) Describe the design and operation of multiplexers with 

schematic diagram. 

10M 3 4   

 
 

10M 
 

2 
 

4 

 15 a) Explain JK-Flip Flop and T-Flip Flop with schematic 

diagram and truth tables. 

(OR) 

 b) Explain about Bi-Directional shift register with 

schematic diagram.  

10M 

 

    

  10M 

    2 

 

       

    2 

5 

   

 

   5 

  

 

 
**All the Best**



 
 

Course Code Title of the Course L T P C 

25BCS204P  DIGITAL LOGIC DESIGN   2 1 

Prerequisites Basic Computer Knowledge 

 

Objectives:                                                                                                                                             

 

1. To provide hands on experience to implement basic logic circuits, combinational and sequential 

circuits. 

 

List of Experiments/Syllabus: 

    
The laboratory work can be done by using physical gates and necessary equipment or simulators.  

Simulators: https://sourceforge.net/projects/gatesim/ or https://circuitverse.org/ or any free open-source 

simulator  

1. Introduction to digital electronics lab- nomenclature of digital ICs, specifications, study of the 

data sheet, concept of Vcc and ground, verification of the truth tables of logic gates using TTL 

ICs.  

2. Implementation of the given Boolean functions using logic gates in both SOP and POS  

forms  

3. Realization of basic gates using universal gates.  

4. Design and implementation of half and full adder circuits using logic gates.  

5. Design and implementation of half and full subtractor circuits using logic gates.  

6. Verification of stable tables of RS, JK, T and D flip-flops using NAND gates.  

7. Implementation and verification of Decoder and encoder using logic gates.  

8. Implementation of 4X1 MUX and DeMUX using logic gates.  

9. Implementation of 8X1 MUX using suitable lower order MUX.  

10. Implementation of 7-segment decoder circuit.  

 

Reference Books:                                                      

1. Digital Logic and Computer Design by M Morris Mano, PHI. 

2. Fundamentals of Logic Design by Charles H. Roth Jr, Jaico Publishers, 5th Edition. 

 

 



 
 
 
 

Skill Courses  
–  

Semester -1 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Common to All Groups – Semester I 

 
Course Code Title of the Course L  S/M P C 

25BCS101S  AI Fundamentals    4  4 

Prerequisites Basics of Computers 

 

COURSE OBJECTIVES 

1 

Understand the history and evolution of Artificial Intelligence and Identify major subfields of 

AI. 

2 Investigate the role of AI in various industries like healthcare, agriculture, and education. 

3 Examine concepts like bias, fairness, transparency, and accountability in AI systems. 

4 

Explore the integration of AI in scientific research and discuss future directions and evolving 

trends in AI. 

5 Learn how prompt engineering is used in various sectors like education and content creation. 

 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Describe the different subfields and their roles in AI applications. 

Understanding 

CO2 
Summarize the benefits and limitations of AI in diverse domains. 

Understanding 

CO3 
Operate AI systems in terms of inclusivity, privacy, and robustness. 

Applying 

CO4 
Practice Generative AI and emerging technologies like ChatGPT. 

Applying 

CO5 
Apply prompt engineering concepts to various real-world use cases. Applying 

 

 

 

 

 

 



Syllabus 
 

COURSE CONTENT 

UNIT I 

Introduction to Artificial Intelligence: History, Definition, Artificial General 

Intelligence, Challenges in AI. Knowledge Engineering, Machine Learning, Computer 

Vision, Natural Language Processing, Robotics. 

UNIT II Applications of AI: Healthcare, Finance, Retail, Agriculture, Education, Transportation. 

UNIT III 

Bias and Fairness in AI Systems: Ethics in AI, Bias and Fairness in AI Systems, Transparency 

in AI Systems, Accountability, Security, Privacy, Inclusivity, Sustainability, Robustness, 

Reliability. 

UNIT IV 

AI in Research, Generative AI and prompt engineering: AI in Experimentation and 

Multi-disciplinary research, Generative AI introduction, ChatGPT, Hugging Face, 

Gemini, Copilot, Perplexity. 

UNIT V 

Prompt engineering: Prompt engineering Definition and its importance, Role of Prompt 

Engineering in AI/ML Interaction.  

Applications of Prompt Engineering: Education, Business & Commerce,  

Content Creation: AI for Creative Writing, AI for creative design, writing AI scripts for video, 

generating slides and slidesGPT usage. 

 

 

TEXT BOOKS 

1. 

AI for Everyone: A Beginner's Handbook for Artificial Intelligence (AI) by Saptarsi Goswami, Amit 

Kumar Das, Amlan Chakrabarti 

2. Prompt Engineering for Beginners: by Kapila Arora, Geetu Garg, Gaurav Arora. 

REFERENCE BOOKS 

1. Let’s Learn Artificial Intelligence: Base Module, Niti Ayog, Atal Innovation Mission.  

2. 

Prompt Engineering for Generative AI: Future-proof inputs for Reliable AI-outputs by James 

Phoenix & Mike Taylor. 

3. 

Generative AI 360°: Practical Guide to ChatGPT, Midjourney & AI Tools to Boost Productivity & 

Creativity, For Professionals, Marketers & Entrepreneurs by Hitesh Motwani, Zebra Learn, 2025. 



WEB RESOURCES 

1. 

Learn Generative AI Prompt Engineering for everyone. https://www.coursera.org/learn/generative-ai-

prompt-engineering-for-everyone?action=enroll 

 

2. 

Generative AI Tutorial: https://www.w3schools.com/gen_ai/ 

 

3. 

Free Artificial Intelligence (AI) Tutorial - Hands-On Prompt Engineering for AI Beginners & Business User 

| Udemy, https://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users 

 

 

 

CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

Model Blue print for the question paper setter 
 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 

https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.w3schools.com/gen_ai/
https://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users


 

AI Fundamentals - Common to all Groups 

Semester-I 
 

Recommended Format of Question Paper for all Courses 
Time: 3 Hours                                                                                                 Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

        OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

        OR 

     B) From Contents of Unit –V 

***** 



 
AI FUNDAMENTALS 

MODEL QUESTION PAPER (W.E.F 2025-2026): Common to All Groups 

Time: 2 ½ Hrs. Max Marks: 70 
Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1 Explain about Machine Learning. 4M 2 1   

2 Discuss about Robotics. 4M     2 1   

3 Illustrate the AI applications in Finance sector 4M 2 2   

4 Explain how AI can be applied in transportation. 4M 2 2   

5 What is ethics in AI? 4M 1 3   

6 Discuss about Accountability and Security in AI 
Systems. 

4M 2 3   

7 How is Copilot used? 4M 2 4   

8 What is Hugging face? 4M 1 4   

9 Define prompt engineering. 4M 1 5   

10 What are the applications of Prompt engineering in 
Education? 

4M 1 5   

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 a)  Define AI? Describe its Applications and 

Challenges. 

(OR) 

b) Write short notes on: 

i)   Computer Vision 

ii) Natural Language Processing 

10M 

 
 
 

10M  

2 

 
 
 
2 

1 

 
 
 
1 

  

2 a) Discuss how AI in applicable in healthcare sector. 

(OR) 

b) Summarize the applications of AI in Agriculture 

10M 
 
 

10M  

2 
 
 

2 

2 
 
 

2 

  

3 a) Explain about Bias and Fairness in AI Systems 

(OR) 

b) Illustrate about the Transparency in AI Systems 

10M 
 

 

10M  

2 
 

 

3 

3 
 
 

3 

  

4 a) Demonstrate Generative AI Tools. 

(OR) 

b) Explain about AI in Experimentation and Multi-

disciplinary research. 

10M 
 
 
 

10M  

3 
 
 
 

2 

4 
 
 
 

4 

  

 5 a) Explain about following Content Creation using AI 

i) Creative Design ii) AI scripts for Video 

(OR) 

b) Discuss about the Role of Prompt Engineering in 

AI/ML Interaction 

 

10M 
 

 
 

   10M  

2 
 

 
 

   2 

5 
 

 
 

5 

  

 

**All the Best**



 
Common to All Groups – Semester I 

Course Code Title of the Course L T P C 

25BCS101L AI FUNDAMENTALS   2 0 

Prerequisites Basic Computer Knowledge 

 

Practice Session 

 

1. Create a mind map of AI subfields: NLP, CV, ML, Robotics, Knowledge Engineering using 

Canva/Napkin AI/ Similar Open AI tool  
 

2. Text Analysis with Open-Source NLP Tools: Tool: Voyant Tools (text analysis web app)  

● Input sample texts (e.g., news articles, speeches).  

● Explore word frequency, keywords, sentiment.  

● Understand how NLP extracts meaning from text.  
 

3. Train a basic image classifier using webcam images. Observe how the model "learns." Using Google 

Teachable Machine  

● Train two image categories (e.g., “Smiling” vs. “Not Smiling”) using their own webcam 

images.  

● Observe how the model learns to classify.  

● Now try feeding images of people with different skin tones, facial features, etc.  

● Observe misclassifications or differences in confidence.  
 

4. Simulate an AI chatbot helping a farmer or a student. You may use any GenAI tool of your choice. 

You may use the prompt below and also try your own.  

Prompt:  

“Act as an agriculture assistant. A farmer wants to know the best crop based on soil and season. 

Ask questions and suggest crops.”  
 

5. Test Generative AI- Generate a poem or image from prompt “A futuristic green city.” using 

ChatGPT, Hugging Face (e.g., image or text generation)  
 

6. Observe how generative AI models may show biased results when prompted with neutral profession 

descriptions. (Bing Image Creator / DALL·E on ChatGPT/ChatGPT). Generate images using the 

following neutral prompts:  

● “A doctor treating a patient”  

● “A teacher in a classroom”  

● “A CEO giving a speech”  

● “A software engineer working from home” Observe and discuss:  

● What gender/race/age are most commonly shown? ● Are the results stereotypical or diverse?  
 

7. Check how language models may express bias depending on names, ethnicity, or location.  



Use ChatGPT or Gemini  

Prompts:  

Prompt A:  

“A person named Raj is applying for a bank loan. Will he be approved?”  

Prompt B: 

“A person named John is applying for a bank loan. Will he be approved?”  

Change names, genders, and nationalities.  

Observe the following and report your findings:  

● Are the responses different?  

● Is one version more positive or negative?  

● Does the model express bias or hesitate?  

● Should AI make such predictions?  

● How do developers prevent this?  
 

8. Exploring Text Generation and Summarization with Google AI Studio  

Generate Creative Content  

“Write a short story (150 words) about a robot who wants to become a chef.”  

● Submit and read the AI-generated story.  

● Discuss how detailed and creative the output is.  

Summarize a Paragraph  

Prompt:  

Summarize the following paragraph in 3 sentences:  

“Artificial Intelligence is a branch of computer science that aims to create intelligent machines 

that can mimic human thinking. It includes various subfields like machine learning, natural 

language processing, and robotics. AI is widely used in industries such as healthcare, finance, 

and transportation to improve efficiency and decision-making.”  

● Submit and review the summary.  

● Evaluate how well AI extracts key points.  

Refine Your Prompt  

Try changing the summary prompt to:  

“Summarize the paragraph above in simple language for 10-year-olds.”  

● Compare this output to the previous one. 

● Note how prompt wording changes results.  
 

9. AI for Creative Writing  

Prompt:  

“Write a short motivational story for 10-year-old students in under 150 words.”  
 

10. Generate Slides: Tool: SlidesGPT/ Another Free AI tool  

Prompt:  

“Create a 5-slide presentation on ‘AI in Smart Farming’.”  
 

11. YouTube Thumbnails / Branding: Tool: Canva + Magic Media AI  

Design a thumbnail using Canva’s AI tools with a prompt like:  

“Design a YouTube thumbnail for a video titled ‘Top 5 AI Tools for Students’.” 

 



 

 

 

 

 

 

 

 

 

 

 

 

Skill Courses  
–  

Semester -2 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Applicable To Computer Science, Data Science, Artificial Intelligence, Cognitive Systems, 

Data Analytics, Cloud Computing, Cyber Security and Any Other Computer Science 

Allied Streams 
Course Code Title of the Course L S/M P C 

25BCS202S  Applications of Artificial Intelligence  3  3 

Prerequisites Basics of Artificial Intelligence 

 

COURSE OBJECTIVES 

1 
Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms 

relevant to Computer science. 

2 
Familiarize students with different types of datasets and public repositories used in AI 

research. 

3 
Develop skills in building AI data pipelines through collection, annotation, cleaning, and 

preprocessing. 

4 
Expose students to no-code AI platforms, vibe coding, and workflow automation tools for 

rapid AI application development. 

5 
Introduce applications of AI in networking, cybersecurity, and digital forensics, highlighting 

both opportunities and challenges. 
 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Explain the role of AI hardware, edge devices, and cloud platforms in 

enabling applications in Computer Science. 
Understanding 

CO2 
Differentiate data types and utilize public datasets relevant to AI. 

Understanding 

CO3 
Implement a conceptual AI data pipeline for solving problems. 

Applying 

CO4 
Apply no-code/low-code AI platforms, vibe coding tools, and 

workflow automation for simple AI-powered applications. 
Applying 

CO5 
Discover the role of AI in networking, cybersecurity, and digital 

forensics, and discuss its challenges and future scope. 
Applying 

 

 

 
 

 



Syllabus 
 

COURSE CONTENT 

UNIT I 

Infrastructure and Platforms for Building Applications using AI:  

 

Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, 

Memory - RAM, VRAM, Storage - HDD, SSD  

Platforms for building applications using AI: Online platforms (Example - Google 

AutoML, H2O.ai; Desktop (No-code/Low code) platforms (Orange Data Mining, 

KNIME.  

Edge AI: Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, 

Surveillance Cameras, Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT II 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI: 

 

Importance of data in building AI applications: Data as the fuel for AI, Role of big data 

in training AI models.  

Conceptual Foundations of Data: Data vs. Information vs. Knowledge.  

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI).  

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Google Dataset Search or similar ones - for demonstration only), Dataset licensing and 

usage rights.  

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Ethical use of 

data, Responsible AI data practices. 

UNIT III 

The AI Data Pipeline: From Collection to Model Readiness:  

 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models  

Core Components: Ingestion, Storage, Processing, Validation, Delivery  

Data Collection Methods for AI: Manual Input (Surveys, forms, human-curated entries), 

Sensors & IoT Devices (Real-time data from physical environments), System Logs & 

Transactions, Web Scraping (Automated extraction from websites), APIs (Structured data 

access from external platforms)  

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation;  

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: 

Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: 

Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data.  

Data Splitting: Splitting data into training set and test set.  

Data Transformation Techniques: Normalization, Transformation. 



UNIT IV 

AI-Powered No-Code Development: Vibe Coding and Workflow Automation  

 

Vibe Coding: Concept & Workflow: What is Vibe Coding and how it works; 

Comparison: Vibe Coding vs. traditional programming;  

Tools Overview: Google AI Studio, Firebase Studio. 

Tool Selection: Choosing the right platform for your needs;  

Benefits & Challenges: Advantages and limitations of Vibe Coding;  

Paradigm Shift: From code-centric to prompt-driven development;  

Prompt Crafting: Structure and examples of effective app prompts. 

 

Workflow Automation using AI: Fundamentals: What is workflow automation and its 

relevance in the AI era;  

Real-world Applications: Auto-email responses, Feedback summarization, social media 

alerts & analytics;  

Toolset Overview: Zapier, n8n. 

UNIT V 

AI in Networks, Cybersecurity, and Forensics:  

 

AI in Networking: Need of AI in Network Management, How AI works in Traffic Prediction 

& Intrusion Detection, Uses of AI in Optimization, Fault Management, and Routing  

AI in Cyber Security: Need of AI in Cyber Security, How AI works in Cyber Security, Uses 

of AI in Cyber Security, Challenges and Considerations of AI in Cyber Security  

AI in Digital Forensics: How AI enhance digital forensic investigations, Role of AI in cyber 

forensic evidence acquisition and analysis, Overcoming challenges and limitations of AI in 

forensics, The future outlook for AI-powered forensic tools 

 

 

 

 

TEXT BOOKS 

1. 

Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, cleaning, 

and visualization without coding) 

2. 

AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world 

use cases). 

REFERENCE BOOKS 

1. 

Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 

quality, preprocessing, and pipelines). 

2. 

Hands-On Data Science for Non-Programmers, David Meerman Scott  

(Spreadsheet-based data exploration and visualization). 

3. You Look Like a Thing and I Love You – Janelle Shane 

WEB RESOURCES 



1. 

Vibe coding: https://cloud.google.com/discover/what-is-vibe-coding  

https://www.ibm.com/think/topics/vibe-coding  

https://firebase.google.com/docs/studio/prompting   

2. 

Workflow Automation:  

https://www.ibm.com/think/topics/workflow-automation  

https://www.ibm.com/think/topics/ai-workflow  

https://n8n.io/ 

3. AI in Cyber Security: https://www.geeksforgeeks.org/ethical-hacking/ai-in-cybersecurity/  

4. 

AI in Networks: https://www.cisco.com/site/us/en/learn/topics/artificial-intelligence/what-is-ai-in 

networking.html  

5. 

AI in Digital Forensics: https://www.eccouncil.org/cybersecurity-exchange/cyber-talks/ai-and-ml-in-digital 

forensics-the-future-of-forensic-investigations/  

 

 

CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

Model Blue print for the question paper setter 
 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 

https://cloud.google.com/discover/what-is-vibe-coding
https://www.ibm.com/think/topics/vibe-coding
https://firebase.google.com/docs/studio/prompting
https://www.ibm.com/think/topics/workflow-automation
https://www.ibm.com/think/topics/ai-workflow
https://www.geeksforgeeks.org/ethical-hacking/ai-in-cybersecurity/
https://www.cisco.com/site/us/en/learn/topics/artificial-intelligence/what-is-ai-in%20networking.html
https://www.cisco.com/site/us/en/learn/topics/artificial-intelligence/what-is-ai-in%20networking.html
https://www.eccouncil.org/cybersecurity-exchange/cyber-talks/ai-and-ml-in-digital%20forensics-the-future-of-forensic-investigations/
https://www.eccouncil.org/cybersecurity-exchange/cyber-talks/ai-and-ml-in-digital%20forensics-the-future-of-forensic-investigations/


 
Applicable To Computer Science, Data Science, Artificial Intelligence, Cognitive Systems, 

Data Analytics, Cloud Computing, Cyber Security and Any Other Computer Science 

Allied Streams - 

Semester-II 

 

Recommended Format of Question Paper  
Time: 2 ½ Hrs                                                                                                 Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

        OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

        OR 

     B) From Contents of Unit –V 

***** 

 



 
Applications of AI – Semester -2 

MODEL QUESTION PAPER (W.E.F 2025-2026): Applicable to Computer Science, Data Science, 

Artificial Intelligence, Cognitive Systems, Data Analytics, Cloud Computing, Cyber Security 

and Any Other Computer Science Allied Streams 

Time: 2 ½ Hrs. Max Marks: 70 
 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1  Explain about any online platform to build AI application. 4M 2 1   

2 State about the Edge AI in smart Appliances. 4M 1 1   

3 Write a short note on “Structure of Data”. 4M 1 2   

4 Explain about Modalities of Data. 4M 2 2   

5 Define the process of Data Annotation and Labelling. 4M 2 3   

6 Discuss about various data collection methods for AI. 4M 2 3   

7 List the Advantages and limitations of Vibe Coding. 4M 1 4   

8 Describe about the Zapier tool. 4M 2 4   

9 Explain about how AI works in Cyber Security. 4M 2 5   

10 Quote the overcoming challenges and limitations of AI in 
forensics. 

4M 1 5   

 

 

 

 

 

 

 

 

 

 

 

 



 

SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 a) Explain the hardware components for building AI 

applications? 

(OR) 

b) Explain briefly about AI in applications in daily 

life appliances? 

10M 
 
 

 
10M  

2 
 
 

 
2 

1 
 
 

 
1 

  

2 a) Explain the importance of data in building AI 

applications? 

(OR) 

b) Discuss about data repositories and data licensing 

in AI? 

10M 
 
 

10M  

2 
 
 
2 

2 
 
 
2 

  

3 a) Summarize about Stages and Components AI 

Data Pipeline? 

(OR) 

b) Distinguish between Data Cleaning/Preprocessing 

and Data Splitting? 

10M 
 

 
10M  

2 
 

 
2 

3 
 

 
3 

  

4 
a) Illustrate the concept of Vibe coding? 

(OR) 

b) Demonstrate the Workflow Automation using AI? 

10M 
 
 
 

10M  

3 
 
 
 

3 

4 
 
 
 

4 

  

 5 a) Summarize the future outlook for AI-powered 

forensic tools? 

(OR) 

b) Classify the uses of AI in Optimization, Fault 

Management, and Routing? 

10M 
 

 

   10M  

2 
 

 

   2 

5 
 

 

5 

  

 

**All the Best**



 
APPLICABLE TO COMPUTER SCIENCE, DATA SCIENCE, ARTIFICIAL 

INTELLIGENCE, COGNITIVE SYSTEMS, DATA ANALYTICS, CLOUD 

COMPUTING, CYBER SECURITY AND ANY OTHER COMPUTER SCIENCE 

ALLIED STREAMS 
Course Code Title of the Course L T P C 

  25BCS202L  Applications of AI   2 1 

Prerequisites Basic Knowledge in AI 

Practice Session 

Suggested Lab Practicals (No Coding)  

Lab 1 - Exploring Public Datasets (Orange Data Mining)  

● Visit a public repository (Kaggle, UCI, data.gov.in)  

● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics)  

● Procedure:  

1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset).  

2. Connect to Data Table → View rows/columns.  

3. Connect to Data Info → Check attributes, data types.  

4. View in Data Table and Distributions widget.  

● Observation: Note numeric, categorical, missing values.  

● Outcome: Students understand structured data format in CSV.  

Lab 2 – Exploring Cybersecurity Datasets (Orange Data Mining)  

● Dataset: Kaggle Cybersecurity dataset.  

https://www.kaggle.com/datasets/teamincribo/cyber-security  

attacks?select=cybersecurity_attacks.csv    

● Procedure:  

1. Load dataset into Orange (File widget).  

2. View using Data Table and Distributions widgets.  

3. Identify numerical (packet size, duration) and categorical (protocol type, attack  

type) attributes.  

● Observation: Note features that indicate “attack” vs. “normal traffic.”  

● Outcome: Students understand the type of features used in intrusion detection.  

Lab 3 - Understanding Dataset Metadata and Formats  

● Take two datasets in different formats (CSV, JSON)  

● View metadata (description, features, size, license)  

● Compare domain-specific datasets (e.g., medical vs. finance)  

Lab 4 - Data Annotation Exercise  

● Use MakeSense.ai or VGG Image Annotator (VIA)  

● Annotate 10 sample images (traffic signs, fruits, or medical scans)  

● Export annotations in XML or YOLO format  

● Discuss annotation errors and challenges  

https://www.kaggle.com/datasets/teamincribo/cyber-security


Lab 5 - Data Cleaning and Visualization (Orange Data Mining)  

● Aim: To clean dirty data and visualize categorical and numeric attributes.  

● Procedure:  

1. Load dataset.  

2. Connect File → Edit Domain (to change types) and Impute (to fill missing values).  

3. Compare cleaned vs. original in Data Table.  

4. Distributions widget.  

5. Check various features distribution.  

(Optional: Create simple bar charts/line charts to visualize trends using Google Looker  

Studio)  

● Observation: Missing values filled with mean/median., Graphical representation of data.  

● Outcome: Learn importance of data cleaning., Students learn importance of visualization  

in preprocessing.  

Lab 6: Train/Test Split in Orange  

● Aim: To split dataset for AI training/testing.  

● Procedure:  

1. Load Titanic dataset.  

2. Connect File → Data Sampler (70% train, 30% test).  

3. Connect outputs to Data Table widgets to view.  

● Observation: Students see two different subsets.  

● Outcome: Concept of model validation using split data.  

Lab 7 – Writing a Detailed Prompt for a Simple Game App (Generative AI)  

● Objective: Understand prompt engineering by designing a game idea.  

● Activity:  

1. Open ChatGPT (or Gemini, Copilot).  

2. Write a detailed prompt like “Create a simple text-based treasure hunt game with  

levels, scoring, and random challenges.”  

3. Ask the AI to refine game rules, scoring, and characters.  

4. Document how prompt detail changes the AI’s response.  

● Outcome: Students learn how detailed prompts shape AI outputs.  

Lab 8 – Create a Portfolio Website using Vibe Coding Tool  

● Objective: Learn how AI-assisted coding tools can automatically generate websites from  

simple instructions.  

● Activity:  

1. Open Vibe Coding Tool (Windsurf/Cursor/Firebase Studio/Any other vibe  

coding tool).  

2. Give a natural language instruction:  

“Create a personal portfolio website for a Computer Science student. It should  

have sections: About Me, Education, Skills, Projects, and Contact.”  

3. Experiment with different prompts to change layout, theme, or color scheme  

(e.g., “Make it a modern dark theme with blue highlights.”).  

4. Preview the generated site and customize content.  

● Outcome: Students experience how AI converts prompt into functional websites with  

minimal coding effort.  

 



Lab 9 – Develop an Interactive Education Quiz App using Vibe Coding Tool  

● Objective: Understand AI’s role in creating educational applications.  

● Activity:  

1. Open Vibe Coding Tool.  

2. Give  

prompt:  

“Build an interactive quiz app for students with multiple-choice questions on AI  

basics. Include features: Start Quiz, Show Score, Retry.”  

3. Refine the app by asking AI to:  

■ Add timer for each question.  

■ Show correct/incorrect answers instantly.  

■ Add a Leaderboard page.  

4. Test the app by playing the quiz.  

● Outcome: Students see how AI-generated apps can support e-learning and assessments.  

Lab 10-Automating Feedback Summarization using n8n and AI  

Objective: Automatically summarize student feedback responses using AI and email the summary  

to the teacher.  

Steps:  

1. Trigger Node: Google Sheets (watch new row for feedback).  

2. AI Node: Send text to OpenAI/Gemini API for summarization.  

(Get a free API from Open Router (https://openrouter.ai/) → Gives free trial credits +  

access to multiple models.)  

3. Action Node: Gmail → email summarized feedback to teacher.  

4. Test: Enter sample feedback in Google Sheet → receive AI summary via email.  

5. Discussion: How AI reduced manual effort in reading every response.  

Outcome: Students see how automation + AI can transform data into insights instantly.  

Lab 11 – Using AI Functions in Google Sheets  

Objective: Enable students to experience Google Sheets’ built-in AI-powered features like  

summarizing, categorizing, sentiment analysis, and text generation through simple prompts within  

the spreadsheet environment.  

Tools & Setup  

Enable Google Sheets with Workspace Labs   

https://workspace.google.com/labs-sign-up/u/1/   

Follow the References and experiment with summarizing, categorizing, sentiment analysis, and  

text generation using =AI() function  

https://support.google.com/docs/answer/15820999?visit_id=638919819014625788-1742465261&p=ai-

function&rd=1     

https://support.google.com/docs/answer/13447609?hl=en&sjid=9077695331310534831-NC   

https://support.google.com/docs/answer/13635180?hl=en&ref_topic=13450085&sjid=90776953313105

34831-NC    

Outcome: Students will experience various AI functions within a spreadsheet-text generation,  

summarization, categorization, sentiment analysis.  

 

 

 

https://workspace.google.com/labs-sign-up/u/1/
https://support.google.com/docs/answer/15820999?visit_id=638919819014625788-1742465261&p=ai-function&rd=1
https://support.google.com/docs/answer/15820999?visit_id=638919819014625788-1742465261&p=ai-function&rd=1
https://support.google.com/docs/answer/13447609?hl=en&sjid=9077695331310534831-NC
https://support.google.com/docs/answer/13635180?hl=en&ref_topic=13450085&sjid=9077695331310534831-NC
https://support.google.com/docs/answer/13635180?hl=en&ref_topic=13450085&sjid=9077695331310534831-NC


Lab 12- Deep Fake Image Detection  

Objective  

Enable students to critically assess image authenticity using multiple free AI tools, understanding  

the strengths and limitations of each.  

Tools:  

Deepfake-O-Meter: https://zinc.cse.buffalo.edu/ubmdfl/deep-o-meter/landing_page   

Decopy AI Image Detector: https://decopy.ai/ai-image-detector/   

Procedure  

1. Collect Images  

○ 2 real images (e.g., faces from Unsplash or personal photos)  

○ 2 AI-generated or manipulated images (e.g., from Midjourney, DALL·E, or  

Google AI studio)  

2. Run through DeepFake-o-Meter  

○ Visit the platform and upload an image.  

○ Note the output: what algorithms flag or overall score for authenticity.  

3. Use Decopy AI Image Detector  

○ Upload the same images.  

○ Check results indicating whether the image appears AI-generated.  

Observation: How AI tools help in Digital Forensics.  

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any other  

similar tool to execute the said lab experiments. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://zinc.cse.buffalo.edu/ubmdfl/deep-o-meter/landing_page
https://decopy.ai/ai-image-detector/


 

Applicable To Botany, Zoology, Bio-Technology, Miro Biology and Other Life Sciences – 

Semester II 

 
Course Code Title of the Course L S/M P C 

  25ZOO202S  Applications of Artificial Intelligence  3  3 

Prerequisites Basics of Artificial Intelligence 

 

COURSE OBJECTIVES 

1 
Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms 

relevant to biological sciences. 

2 
Familiarize students with different types of datasets and public repositories used in AI 

research. 

3 
Develop skills in building AI data pipelines through collection, annotation, cleaning, and 

preprocessing. 

4 
Explore the integration of AI in scientific research and discuss future directions and evolving 

trends in AI. 

5 
Introduce AI-driven approaches in biotechnology and chemistry, such as genome sequencing, 

protein structure prediction, and drug discovery. 
 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Explain the role of AI hardware, edge devices, and cloud platforms in 

enabling applications in biological sciences. 
Understanding 

CO2 
Differentiate data types and utilize public datasets relevant to AI in life 

sciences. 
Understanding 

CO3 
Implement a conceptual AI data pipeline for solving biological 

problems. 
Applying 

CO4 
Apply AI techniques in case studies of agriculture, zoology, ecology, 

and environmental monitoring. 
Applying 

CO5 
Discover the impact of AI in biotechnology and chemistry, particularly 

in genome sequencing, protein prediction, and drug discovery 
Applying 

 

 

 

 
 



 

Syllabus 
 

COURSE CONTENT 

UNIT I 

Infrastructure and Platforms for Building Applications using AI:  

 

Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, 

Memory - RAM, VRAM, Storage - HDD, SSD  

Platforms for building applications using AI: Online platforms (Example - Google 

AutoML, H2O.ai; Desktop (No-code/Low code) platforms (Orange Data Mining, 

KNIME.  

Edge AI: Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, 

Surveillance Cameras, Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT II 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI: 

 

Importance of data in building AI applications: Data as the fuel for AI, Role of big data 

in training AI models.  

Conceptual Foundations of Data: Data vs. Information vs. Knowledge.  

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI).  

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Google Dataset Search or similar ones - for demonstration only), Dataset licensing and 

usage rights.  

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Ethical use of 

data, Responsible AI data practices. 

UNIT III 

The AI Data Pipeline: From Collection to Model Readiness:  

 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models  

Core Components: Ingestion, Storage, Processing, Validation, Delivery  

Data Collection Methods for AI: Manual Input (Surveys, forms, human-curated entries), 

Sensors & IoT Devices (Real-time data from physical environments), System Logs & 

Transactions, Web Scraping (Automated extraction from websites), APIs (Structured data 

access from external platforms)  

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation;  

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: 

Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: 

Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data.  

Data Splitting: Splitting data into training set and test set.  

Data Transformation Techniques: Normalization, Transformation. 



UNIT IV 

AI in Biological Sciences:  

AI in Botany & Agriculture: Plant disease detection via image recognition; Crop yield 

forecasting using climate and soil analytics; Precision agriculture: smart irrigation and 

fertilizer planning. 

AI in Zoology, Ecology & Environmental Sciences: Wildlife monitoring: species ID 

from camera trap data; Aquatic systems: fish recognition and water quality modeling; 

Livestock health and disease prediction; Environmental tracking: forest cover and 

pollution analysis 

UNIT V 

AI in Bio-Technology and Bio-Chemistry:  

Application of AI in Genome sequencing & gene function prediction; Using AI in Protein 

structure modeling (e.g., AlphaFold); AI for Drug discovery: virtual compound screening; 

Application of AI in Microbial classification & metagenomic profiling; Chemical reaction and 

material property prediction 

 

TEXT BOOKS 

1. 

Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, cleaning, 

and visualization without coding) 

2. 

AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world 

use cases). 

REFERENCE BOOKS 

1. 

Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 

quality, preprocessing, and pipelines). 

2. 

Hands-On Data Science for Non-Programmers, David Meerman Scott  

(Spreadsheet-based data exploration and visualization). 

3. Artificial Intelligence in Life Sciences – Elsevier. 

4. Artificial Intelligence in Agriculture – CRC Press (B. Prasad). 

5. AI for Ecology and Conservation – Springer. 

6. Bioinformatics and Drug Discovery using AI – Academic Press. 

WEB RESOURCES 

1. Kaggle Dataset Search, https://www.kaggle.com/datasets 

2. Google Dataset Search, https://datasetsearch.research.google.com  

3. UCI Machine Learning Repository, https://archive.ics.uci.edu  

4. Hugging Face Datasets, https://huggingface.co/datasets  

5. Open Government Data (India), https://data.gov.in  

 

https://www.kaggle.com/datasets
https://datasetsearch.research.google.com/
https://archive.ics.uci.edu/
https://huggingface.co/datasets
https://data.gov.in/


CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

Model Blue print for the question paper setter 
 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 



 
Applicable To Botany, Zoology, Bio-Technology, Miro Biology and Other Life Sciences 

Semester-II 

 

Recommended Format of Question Paper  
Time: 2 ½ Hrs                                                                                                Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

        OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

        OR 

     B) From Contents of Unit –V 

***** 



 
Applications of AI  

MODEL QUESTION PAPER (W.E.F 2025-2026): Applicable to Botany, Zoology, Bio-Technology, 

Miro Biology and Other Life Sciences 

Time: 2 ½ Hrs. Max Marks: 70 
 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1  Explain about any online platform to build AI application. 4M 2 1   

2 State about the Edge AI in smart Appliances. 4M 1 1   

3 Write a short note on “Structure of Data”. 4M 1 2   

4 Explain about Modalities of Data. 4M 2 2   

5 Define the process of Data Annotation and Labelling. 4M 2 3   

6 Discuss about various data collection methods for AI. 4M 2 3   

7 Write short note on Precision agriculture. 4M 1 4   

8 Discuss about the role of AI in Environmental tracking. 4M 2 4   

9  Explain the role of AI in Protein structure modeling? 4M 2 5   

10  Illustrate the application of AI in Microbial classification. 4M 2 5   

 

 

 

 

 

 

 

 

 

 

 

 

 



 

SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 a) Explain the hardware components for building AI 

applications? 

(OR) 

b) Explain briefly about AI in applications in daily 

life appliances? 

10M 
 
 

 
10M  

2 
 
 

 
2 

1 
 
 

 
1 

  

2 a) Explain the importance of data in building AI 

applications? 

(OR) 

b) Discuss about data repositories and data licensing 

in AI? 

10M 
 
 

10M  

2 
 
 
2 

2 
 
 
2 

  

3 a) Summarize about Stages and Components AI 

Data Pipeline? 

(OR) 

b) Distinguish between Data Cleaning/Preprocessing    

and Data Splitting? 

10M 
 

 
10M  

2 
 

 
2 

3 
 

 
3 

  

4 
a) Discuss the advantages of using AI for plant disease 

detection compared to traditional methods? 

(OR) 

b) Describe the techniques used by AI models for fish 

recognition in aquatic ecosystems? 

10M 
 
 
 

10M  

2 
 
 
 

2 

4 
 
 
 

4 

  

 5 a) Explain the role of AI in Drug discovery. 

(OR) 

b) Compare and contrast traditional bioinformatics 

approaches with AI-driven methods for gene 

function prediction. What are the advantages and 

limitations? 

10M 
 
 

   10M  

2 
 
 

   2 

5 
 
 

5 

  

 

 

 
 

**All the Best**



 
Applicable To Botany, Zoology, Bio-Technology, Miro Biology and Other Life Sciences 

Course Code Title of the Course L T P C 

   25ZOO202L Applications of AI   2 1 

Prerequisites Basic Knowledge in AI 

Practice Session 

Lab Practicals (No Coding) 

 

 Lab 1 - Exploring Public Datasets (Orange Data Mining)  

 ● Visit a public repository (Kaggle, UCI, data.gov.in)  

 ● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics)  

 ● Procedure: 1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 2. Connect to 

Data Table → View rows/columns. 3. Connect to Data Info → Check attributes, data types. 4. View in 

Data Table and Distributions widget.  

 ● Observation: Note numeric, categorical, missing values.  

 ● Outcome: Students understand structured data format in CSV.  

Lab 2 - Understanding Dataset Metadata and Formats  

 ● Take two datasets in different formats (CSV, JSON)  

 ● View metadata (description, features, size, license)  

 ● Compare domain-specific datasets (e.g., medical vs. finance)  

Lab 3 - Data Annotation Exercise  

 ● Use MakeSense.ai or VGG Image Annotator (VIA)  

 ● Annotate 10 sample images (traffic signs, fruits, or medical scans)  

 ● Export annotations in XML or YOLO format  

 ● Discuss annotation errors and challenges  

Lab 4 - Data Cleaning and Visualization (Orange Data Mining)  

 ● Aim: To clean dirty data and visualize categorical and numeric attributes.  

 ● Procedure: 1. Load dataset. 2. Connect File → Edit Domain (to change types) and Impute (to fill missing 

values). 3. Compare cleaned vs. original in Data Table. 4. Distributions widget. 5. Check various features 

distribution. (Optional: Create simple bar charts/line charts to visualize trends using Google Looker Studio) 

● Observation: Missing values filled with mean/median., Graphical representation of data.  

 ● Outcome: Learn importance of data cleaning., Students learn importance of visualization in 

preprocessing.  

Lab 5: Train/Test Split in Orange  

 ● Aim: To split a dataset for AI training/testing.  

 ● Procedure: 1. Load Titanic dataset. 2. Connect File → Data Sampler (70% train, 30% test). 3. Connect 

outputs to Data Table widgets to view.  

 ● Observation: Students see two different subsets.  

 ● Outcome: Concept of model validation using split data.  

 



Lab 6: Plant Leaf Disease Detection  

 ● Dataset: Plant leaf disease datasets (PlantVillage, Kaggle).  

 ● Tool: Google Teachable Machine / Plantix app.  

 ● Activity: Upload leaf images to classify healthy vs diseased leaves.  

Lab 7: Crop Yield Prediction  

 ● Dataset: FAO crop yield datasets.  

 ● Tool: Orange Data Mining (drag-and-drop AI workflows).  

 ● Activity: Predict yield for different crops based on soil & climate features.  

Lab 8: Species Recognition  

 ● Dataset: Camera trap image datasets (Snapshot Serengeti, LILA BC).  

 ● Tool: iNaturalist / Wildbook AI platform.  

 ● Activity: Upload wildlife images for species recognition & conservation mapping.  

Lab 9: Predict and visualize 3D protein structures:  

 ● Dataset: Genomic & protein sequence databases (NCBI, UniProt, AlphaFold DB).  

 ● Tool: AlphaFold Protein Structure Viewer (online).  

 ● Activity: Predict and visualize 3D protein structures.  

Lab 10: Analyze chemical similarity and predict drug-likeness.  

 ● Dataset: Drug compound datasets (ChEMBL).  

 ● Tool: ChemMine Tools (web-based).  

 ● Activity: Analyze chemical similarity and predict drug-likeness.  

Lab 11: Identify microbial species from sequencing datasets.  

 ● Dataset: Metagenomics datasets (MG-RAST).  

 ● Tool: MG-RAST online platform.  

 ● Activity: Identify microbial species from sequencing datasets. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Applicable To Commerce and Management – Semester II 

 
Course Code Title of the Course L S/M P C 

25BCG202S 
25BCC202S 
25BBA202S 
25BFS202S 

 

Applications of Artificial Intelligence 

  

3 

  
3 

Prerequisites Basics of Artificial Intelligence 

 

COURSE OBJECTIVES 

1 
Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms 

relevant to commerce and management. 

2 
Familiarize students with different types of datasets and public repositories used in AI 

research. 

3 
Develop skills in building AI data pipelines through collection, annotation, cleaning, and 

preprocessing. 

4 
Understand how AI enhances retail and e-commerce and explore personalization, 

recommendation systems, and customer engagement. 

5 
Apply AI to streamline business processes and decision-making and explore AI in finance, 

HR, and supply chain management. 
 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Explain the AI ecosystem (hardware, cloud, and edge devices) and its 

relevance to commerce and management. 
Understanding 

CO2 
Differentiate between structured and unstructured data, and utilize 

public datasets for business-oriented AI applications. 
Understanding 

CO3 
Implement a conceptual AI data pipeline for solving real-world 

problems in commerce and management. 
Applying 

CO4 
Understand and apply AI technologies to improve customer 

engagement and personalization in commerce. 
Understanding 

CO5 
Use AI tools to streamline business operations, enhance decision-

making, and detect patterns in data. 
Applying 

 

 

 



Syllabus 
 

COURSE CONTENT 

UNIT I 

Infrastructure and Platforms for Building Applications using AI:  

 

Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, 

Memory - RAM, VRAM, Storage - HDD, SSD  

Platforms for building applications using AI: Online platforms (Example - Google 

AutoML, H2O.ai; Desktop (No-code/Low code) platforms (Orange Data Mining, 

KNIME.  

Edge AI: Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, 

Surveillance Cameras, Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT II 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI: 

 

Importance of data in building AI applications: Data as the fuel for AI, Role of big data 

in training AI models.  

Conceptual Foundations of Data: Data vs. Information vs. Knowledge.  

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI).  

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Google Dataset Search or similar ones - for demonstration only), Dataset licensing and 

usage rights.  

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Ethical use of 

data, Responsible AI data practices. 

UNIT III 

The AI Data Pipeline: From Collection to Model Readiness:  

 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models  

Core Components: Ingestion, Storage, Processing, Validation, Delivery  

Data Collection Methods for AI: Manual Input (Surveys, forms, human-curated entries), 

Sensors & IoT Devices (Real-time data from physical environments), System Logs & 

Transactions, Web Scraping (Automated extraction from websites), APIs (Structured data 

access from external platforms)  

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation;  

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: 

Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: 

Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data.  

Data Splitting: Splitting data into training set and test set.  

Data Transformation Techniques: Normalization, Transformation. 



UNIT IV 

AI in Commerce – Transforming the Consumer Experience  

 

Introduction to AI in Commerce, Recommendation Engines (Collaborative & Content-

Based), Chatbots and Virtual Assistants, Sentiment Analysis and Review Mining, 

Inventory Optimization and Demand Forecasting, Ethical Issues related to use of AI in 

Commerce and Business: Bias, Privacy, and Transparency. 

UNIT V 

AI in Business Operations – Driving Efficiency and Insight:  

AI in Business Intelligence and Predictive Analytics, Financial Applications: Fraud Detection, 

Risk Modelling, HR Applications: Resume Screening, Employee Analytics, Supply Chain 

Automation and Optimization, AI in Marketing: Customer Segmentation, Lead Scoring, 

Strategic Adoption of AI in Enterprises, Explainable AI in E-Commerce. 

 

 

TEXT BOOKS 

1. 

Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, cleaning, 

and visualization without coding) 

2. 

AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world 

use cases). 

REFERENCE BOOKS 

1. 

Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 

quality, preprocessing, and pipelines). 

2. 

Hands-On Data Science for Non-Programmers, David Meerman Scott  

(Spreadsheet-based data exploration and visualization). 

3. You Look Like a Thing and I Love You – Janelle Shane 

WEB RESOURCES 

1. Kaggle Dataset Search, https://www.kaggle.com/datasets 

2. Google Dataset Search, https://datasetsearch.research.google.com  

3. UCI Machine Learning Repository, https://archive.ics.uci.edu  

4. Hugging Face Datasets, https://huggingface.co/datasets  

5. Open Government Data (India), https://data.gov.in  

 

 

 

 

 

https://www.kaggle.com/datasets
https://datasetsearch.research.google.com/
https://archive.ics.uci.edu/
https://huggingface.co/datasets
https://data.gov.in/


CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

Model Blue print for the question paper setter 
 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 



 
Applicable To Commerce and Management- 

Semester-II 
 

Recommended Format of Question Paper  
Time: 2 ½ Hrs           Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

        OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

        OR 

     B) From Contents of Unit –V 

***** 

 

 



 
Applications of AI  

MODEL QUESTION PAPER (W.E.F 2025-2026): Applicable to Commerce and Management 

Time: 2 ½ Hrs. Max Marks: 50 
 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1  Explain about any online platform to build AI application. 4M 2 1   

2 State about the Edge AI in smart Appliances. 4M 1 1   

3 Write a short note on “Structure of Data”. 4M 1 2   

4 Explain about Modalities of Data. 4M 2 2   

5 Define the process of Data Annotation and Labelling. 4M 2 3   

6 Discuss about various data collection methods for AI. 4M 2 3   

7 Write short note on Sentiment Analysis and Review 
Mining. 

4M 1 4   

8 Discuss about the role of AI in Inventory Optimization and 
Demand Forecasting. 

4M 2 4   

9  Explain the role of AI in HR Applications? 4M 2 5   

10  Illustrate the “Explainable AI in E-Commerce”. 4M 2 5   

 

 

 

 

 

 

 

 

 

 

 

 

 



SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 a) Explain the hardware components for building AI 

applications? 

(OR) 

b) Explain briefly about AI in applications in daily 

life appliances? 

10M 
 

 
 

10M  

2 
 

 
 
2 

1 
 

 
 
1 

  

2 a) Explain the importance of data in building AI 

applications? 

(OR) 

b) Discuss about data repositories and data licensing 

in AI? 

10M 
 
 

10M  

2 
 
 
2 

2 
 
 
2 

  

3 a) Summarize about Stages and Components AI 

Data Pipeline? 

(OR) 

b) Distinguish between Data Cleaning/Preprocessing    

and Data Splitting? 

10M 

 
 

10M  

2 

 
 

2 

3 

 
 

3 

  

4 a) Describe the Ethical Issues in AI Commerce in 

detail? 

(OR) 

b) Classify the Chatbots and Virtual Assistants in 

AI? 

10M 
 
 

 
10M  

3 
 
 

 
2 

4 
 
 

 
4 

  

 5 a) Explain the various applications of AI Business 

Intelligence? 

                                  (OR) 

b) Explain about AI in Marketing? 

10M 
 
 

   10M  

2 
 
 

   2 

5 
 
 

5 

  

 

 
 

**All the Best**



 
APPLICABLE TO COMMERCE AND MANAGEMENT 

Course Code Title of the Course L T P C 

25BCG202L 
25BCC202L 
25BBA202L 

      25BFS202L 

 

Applications of AI 

   
2 

 
1 

Prerequisites Basic Knowledge in AI 

Practice Session 

Lab Practicals (No Coding) 

 

 Lab 1 - Exploring Public Datasets (Orange Data Mining)  

 ● Visit a public repository (Kaggle, UCI, data.gov.in)  

 ● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics)  

 ● Procedure: 1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 2. Connect to 

Data Table → View rows/columns. 3. Connect to Data Info → Check attributes, data types. 4. View in 

Data Table and Distributions widget.  

 ● Observation: Note numeric, categorical, missing values.  

 ● Outcome: Students understand structured data format in CSV.  

Lab 2 - Understanding Dataset Metadata and Formats  

 ● Take two datasets in different formats (CSV, JSON)  

 ● View metadata (description, features, size, license)  

 ● Compare domain-specific datasets (e.g., medical vs. finance)  

Lab 3 - Data Annotation Exercise  

 ● Use MakeSense.ai or VGG Image Annotator (VIA)  

 ● Annotate 10 sample images (traffic signs, fruits, or medical scans)  

 ● Export annotations in XML or YOLO format  

 ● Discuss annotation errors and challenges  

Lab 4 - Data Cleaning and Visualization (Orange Data Mining)  

 ● Aim: To clean dirty data and visualize categorical and numeric attributes.  

 ● Procedure: 1. Load dataset. 2. Connect File → Edit Domain (to change types) and Impute (to fill missing 

values). 3. Compare cleaned vs. original in Data Table. 4. Distributions widget. 5. Check various features 

distribution. (Optional: Create simple bar charts/line charts to visualize trends using Google Looker Studio) 

● Observation: Missing values filled with mean/median., Graphical representation of data.  

 ● Outcome: Learn importance of data cleaning., Students learn importance of visualization in 

preprocessing.  

Lab 5: Train/Test Split in Orange  

 ● Aim: To split a dataset for AI training/testing.  

 ● Procedure: 1. Load Titanic dataset. 2. Connect File → Data Sampler (70% train, 30% test). 3. Connect 

outputs to Data Table widgets to view.  

 ● Observation: Students see two different subsets.  



 ● Outcome: Concept of model validation using split data.  

 

 

Lab 6: Introduction to AI in Commerce – Use Case Exploration  

 Prerequisite: Discuss conceptually about Clustering  

 Objective: Understand how AI is applied in commerce through data visualization and clustering. Orange 

Workflow: Use Orange Data Mining Tool  

 Widgets Used: File → Data Table → Scatter Plot → Hierarchical Clustering Dataset: Retail customer data 

(e.g., purchase frequency, amount spent)  

 Dataset Link: Retail Sales Data  

 Activities: · · · Load customer data and visualize spending patterns. Apply clustering to identify customer 

segments. Discuss how businesses can tailor services to each segment.  

 Outcome: Students grasp how AI helps businesses understand and target consumers more effectively.  

Lab 7: Recommendation Engine Simulation  

Prerequisite: Discuss conceptually about Clustering  

Objective: Simulate collaborative filtering using similarity-based clustering.  

Orange Workflow:  

Widgets Used: File → Distance → Hierarchical Clustering → Data Table  

Dataset: User-product ratings matrix  

Dataset Link: Amazon Product Recommendation System  

Activities:  

● Calculate similarity between users.  

● Group similar users and recommend products based on cluster behavior.  

● Discuss differences between collaborative and content-based filtering.  

Outcome: Students understand the logic behind recommendation systems and how they  

personalize user experience.  

Lab 8: Chatbot Intent Classification  

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  

Objective: Train a model to classify customer queries into intents.  

Orange Workflow:  

Widgets Used: File → Preprocess Text → Bag of Words → Logistic Regression → Test &  

Score  

Dataset: Sample customer queries labeled with intents (e.g., “track order”, “return item”)  

Dataset Link: Customer Intent Classification  

Activities:  

● Preprocess and vectorize text data.  

● Train a classifier to predict query intent.  

● Evaluate accuracy and discuss chatbot training.  

Outcome: Students learn how AI understands and responds to customer queries.  

Lab 9: Sentiment Analysis of Reviews  

Prerequisite: Discuss conceptually about Naive Bayes  

Objective: Classify customer reviews as positive or negative.  

Orange Workflow:  

Widgets Used: File → Preprocess Text → Bag of Words → Naive Bayes → Test & Score  

Dataset: Product reviews with sentiment labels  



Dataset Link: Amazon Product Reviews – Sentiment Analysis  

Activities:  

● Clean and tokenize review text.  

● Train a sentiment classifier.  

● Visualize word clouds for positive vs. negative reviews.  

Outcome: Students analyze customer feedback and extract actionable insights.  

Lab 10: Demand Forecasting with Regression  

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  

Objective: Predict future sales using regression models.  

Orange Workflow:  

Widgets Used: File → Linear Regression → Scatter Plot → Test & Score    

Dataset: Historical sales data (e.g., monthly sales, promotions)  

Dataset Link: Comprehensive Retail Sales Data  

Activities:  

● Train a regression model to forecast sales.  

● Visualize predictions vs. actuals.  

● Discuss implications for inventory planning.  

Outcome: Students understand how AI supports demand forecasting and inventory control.  

Lab 11: Bias Detection in AI Models  

Prerequisite: Discuss conceptually about Linear Regression, Logistic Regression & Confusion  

Matrix  

Objective: Explore bias in predictive models and its impact.  

Orange Workflow:  

Widgets Used: File → Logistic Regression → Confusion Matrix → Distributions   

Dataset: HR hiring data with gender or age attributes  

Dataset Link: HR Data Analytics  

Activities:  

● Train a model to predict hiring decisions.  

● Analyze performance across demographic groups.  

● Discuss fairness, transparency, and ethical implications.  

Outcome: Students critically assess bias and propose ethical safeguards.  

Lab 12: Predictive Analytics for Business Intelligence  

Prerequisite: Discuss conceptually about Random Forest  

Objective: Use classification to predict customer churn.  

Orange Workflow:  

Widgets Used: File → Random Forest → Test & Score → ROC Analysis  

Dataset: Telecom or subscription data with churn labels  

Dataset Link: Telco Customer Churn – IBM Dataset  

Activities:  

● Train and evaluate a churn prediction model.  

● Interpret ROC curves and accuracy.  

● Discuss how businesses can act on predictions.  

Outcome: Students apply predictive analytics to improve customer retention.  

 

Lab 13: AI in HR and Marketing – Resume Screening & Segmentation  



Prerequisite: Discuss conceptually about Clustering  

Objective: Classify resumes and segment customers using clustering.  

Orange Workflow:  

HR Task: File → Preprocess Text → Bag of Words → Logistic Regression  

Marketing Task: File → k-Means Clustering → Scatter Plot   

Resume Screening Dataset: Employee Hiring Data  

Customer Segmentation Dataset: Customer Segmentation Dataset  

Activities:  

● Screen resumes based on job fit.  

● Segment customers by behavior or demographics.  

● Discuss automation benefits and risks.  

Outcome: Students explore how AI enhances HR and marketing efficiency.  

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any other  

similar tool to execute the said lab experiments. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Applicable To History, Economics, Political Science, Linguistics, And Any Other 

Humanities– Semester II 

 
Course Code Title of the Course L S/M P C 

25HIS202S 
25ECO202S 

 Applications of Artificial Intelligence  3  3 

Prerequisites Basics of Artificial Intelligence 

 

COURSE OBJECTIVES 

1 
Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms, in a 

non-technical way for Arts and Social Sciences students. 

2 
Familiarize students with data types, sources, and public repositories that fuel AI applications 

in society and humanities. 

3 
Explain the process of preparing and managing AI data pipelines through collection, 

annotation, and cleaning. 

4 Explore real-world applications of AI in arts, culture, literature, linguistics, and languages. 

5 
Introduce applications of AI in social sciences such as economics, political science, 

psychology, history, and sociology, with an emphasis on ethics and responsible adoption. 
 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Explain the AI ecosystem (hardware, cloud, edge devices) and its 

societal relevance. 
Understanding 

CO2 
Differentiate data types and identify public datasets relevant to social 

sciences, arts, and humanities. 
Understanding 

CO3 
Describe the steps of an AI data pipeline (collection, annotation, 

cleaning, preparation) in simple terms. 
Understanding 

CO4 
Illustrate the role of AI in arts, languages, and cultural heritage with 

practical, real-world examples. 
Applying 

CO5 
Discover applications of AI in social sciences (economics, politics, 

psychology, history, and society) and evaluate ethical concerns. 
Applying 

 

 

 

 

 



Syllabus 
 

COURSE CONTENT 

UNIT I 

Infrastructure and Platforms for Building Applications using AI:  

 

Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, 

Memory - RAM, VRAM, Storage - HDD, SSD  

Platforms for building applications using AI: Online platforms (Example - Google 

AutoML, H2O.ai; Desktop (No-code/Low code) platforms (Orange Data Mining, 

KNIME.  

Edge AI: Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, 

Surveillance Cameras, Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT II 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI: 

 

Importance of data in building AI applications: Data as the fuel for AI, Role of big data 

in training AI models.  

Conceptual Foundations of Data: Data vs. Information vs. Knowledge.  

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI).  

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Google Dataset Search or similar ones - for demonstration only), Dataset licensing and 

usage rights.  

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Ethical use of 

data, Responsible AI data practices. 

UNIT III 

The AI Data Pipeline: From Collection to Model Readiness:  

 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models  

Core Components: Ingestion, Storage, Processing, Validation, Delivery  

Data Collection Methods for AI: Manual Input (Surveys, forms, human-curated entries), 

Sensors & IoT Devices (Real-time data from physical environments), System Logs & 

Transactions, Web Scraping (Automated extraction from websites), APIs (Structured data 

access from external platforms)  

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation;  

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: 

Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: 

Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data.  

Data Splitting: Splitting data into training set and test set.  

Data Transformation Techniques: Normalization, Transformation. 



UNIT IV 

AI in Social Sciences and Society:  

 

AI in Economics: Predicting market trends, consumer behavior, and economic 

forecasting.  

AI in Political Science & Public Policy: Social media analysis for political campaigns, 

Opinion mining & election trend prediction.  

AI in Psychology & Sociology: Emotion recognition from facial expressions and text, AI 

chatbots in mental health counseling (conceptual).  

AI in History & Society: Digital archives and historical document analysis, AI for 

preserving ancient languages and scripts, social impact of AI on jobs, privacy, and 

democracy. 

UNIT V 

AI in Arts, Languages, and Cultural Studies:  

AI in Literature & Languages: Machine translation (Google Translate, DeepL), Sentiment 

analysis in literature and media reviews, AI-assisted creative writing (chatbots, story 

generators, poetry)  

AI in Arts & Culture: AI in music composition & art generation (painting, film scripts), 

Digitization and preservation of cultural heritage using AI, Identifying fake art and forgeries. 

 

TEXT BOOKS 

1. 

Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, cleaning, 

and visualization without coding) 

2. 

AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world 

use cases). 

REFERENCE BOOKS 

1. 

Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 

quality, preprocessing, and pipelines). 

2. 

Hands-On Data Science for Non-Programmers, David Meerman Scott  

(Spreadsheet-based data exploration and visualization). 

3. You Look Like a Thing and I Love You – Janelle Shane 

WEB RESOURCES 

1. Kaggle Dataset Search, https://www.kaggle.com/datasets 

2. Google Dataset Search, https://datasetsearch.research.google.com  

3. UCI Machine Learning Repository, https://archive.ics.uci.edu  

4. Hugging Face Datasets, https://huggingface.co/datasets  

5. Open Government Data (India), https://data.gov.in  

 

https://www.kaggle.com/datasets
https://datasetsearch.research.google.com/
https://archive.ics.uci.edu/
https://huggingface.co/datasets
https://data.gov.in/


 

CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

Model Blue print for the question paper setter 
 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 



 
Applicable To History, Economics, Political Science, Linguistics, And Any Other 

Humanities - 

Semester-II 
 

Recommended Format of Question Paper  
Time: 2 ½ Hrs                                                                                                Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                     5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

        OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

        OR 

     B) From Contents of Unit –V 

***** 

 



 
Applications of AI  

MODEL QUESTION PAPER (W.E.F 2025-2026): Applicable to History, Economics, Political 

Science, Linguistics, and Any Other Humanities 

Time: 2 ½ Hrs. Max Marks: 50 
 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1  Explain about any online platform to build AI application. 4M 2 1   

2 State about the Edge AI in smart Appliances. 4M 1 1   

3 Write a short note on “Structure of Data”. 4M 1 2   

4 Explain about Modalities of Data. 4M 2 2   

5 Define the process of Data Annotation and Labelling. 4M 2 3   

6 Discuss about various data collection methods for AI. 4M 2 3   

7 Write short note Chatbots and Virtual Assistants in AI in 
Psychology & Sociology. 

4M 1 4   

8 Discuss about the Opinion mining & election trend 
prediction? 

4M 2 4   

9  Explain the role of AI in Sentiment analysis in literature 

and media reviews? 

4M 2 5   

10  Illustrate the application of AI in Identifying fake art and 
forgeries. 

4M 2 5   

 

 

 

 

 

 

 

 

 

 

 

 



 

 

SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 a) Explain the hardware components for building AI 

applications? 

(OR) 

b) Explain briefly about AI in applications in daily 

life appliances? 

10M 

 
 
 

10M  

2 

 
 
 
2 

1 

 
 
 
1 

  

2 a) Explain the importance of data in building AI 

applications? 

(OR) 

b) Discuss about data repositories and data licensing 

in AI? 

10M 
 
 

10M  

2 
 
 

2 

2 
 
 

2 

  

3 a) Summarize about Stages and Components AI 

Data Pipeline? 

(OR) 

b) Distinguish between Data Cleaning/Preprocessing 

and Data Splitting? 

10M 

 
 

10M  

2 

 
 

2 

3 

 
 

3 

  

4 
a) Illustrate about the AI in History & Society 

 

(OR) 

b) Demonstrate about AI in Economics. 

10M 
 
 

 
10M  

3 
 
 

 
3 

4 
 
 

 
4 

  

 5 a) Summarize the role of AI in Literature & 

Languages? 

(OR) 

b) Classify the uses of AI in Arts & Culture? 

10M 
 
 

   10M  

2 
 
 

   2 

5 
 
 

5 

  

 

 

 
 

**All the Best**



 
APPLICABLE TO HISTORY, ECONOMICS, POLITICAL SCIENCE, LINGUISTICS, 

AND ANY OTHER HUMANITIES 
Course Code Title of the Course L T P C 

25HIS202L 
25ECO202L 

Applications of AI   2 1 

Prerequisites Basic Knowledge in AI 

Practice Session 

Lab Experiments:  

Lab 1: Explore Open Data (Economics / Sociology)  

● Tool: Our World in Data (https://data360.worldbank.org/en/search) or World Bank Data Explorer  

● Task: Choose indicators (e.g., Literacy, GDP per capita, Poverty, Unemployment).  

● Procedure:  

1. Open World Bank / Our World in Data.  

2. Select one country or compare multiple countries.  

3. Use the interactive charts to see historical trends.  

● Observation: How does education level impact income or health?  

● Outcome: Understand correlations between socio-economic indicators.  

Lab 2: Data Annotation (NER & Classification)  

● Tool: Prodigy Demo (https://demo.prodi.gy/) -free online demo, no install  

● Activity:  

1. Try Named Entity Recognition (NER) demo.  

2. Highlight organizations, people, and places in sample text.  

3. Compare manual vs. automated annotation.  

● Outcome: Students understand manual vs. automated annotation and why labeling is  

crucial.  

Lab 3: Automatic Text Classification for Sociology  

● Tool: Text2Data Sentiment Analysis Demo (https://text2data.com/Demo) -free online  

demo  

● Task: Copy-paste 5 messages related to climate change, caste or gender.  

● Observation: Tool classifies them as Positive, Neutral, or Negative.  

● Outcome: Understand “annotation” and “classification labels.”  

Lab 4: Word Clouds for Political Speeches (Languages / Political Science)  

● Tool: WordArt Cloud Generator (https://wordart.com/create) - Free Online  

● Procedure:  

1. Copy a Prime Minister’s speech or Economic Budget highlights.  

2. Paste into WordArt.  

3. Generate a word cloud → biggest words = most repeated.  

● Observation: Main themes in political communication.  

● Outcome: Learn how text visualization shows political/economic priorities.  



Lab 5: Bias in Job Advertisements (Sociology / Gender Studies)  

● Tool: Gender Decoder for Job Ads (https://gender-decoder.katmatfield.com/) -Free Online  

or any other related tool  

● Procedure:  

1. Copy text from 5 job advertisements.  

2. Paste into the gender bias detector.  

3. Note masculine vs feminine coded words.  

● Observation: How language influences gendered hiring.  

● Outcome: Awareness of AI in analyzing workplace bias.  

Lab 6: Language Detection & Translation (Languages / Linguistics)  

● Tool: Google Translate (https://translate.google.co.in/)   

● Task: Enter text in regional/foreign languages.  

● Procedure:  

1. Paste short paragraph in Telugu, Hindi, French, etc.  

2. Translate into English.  

3. Reverse-translate to see changes.  

● Observation: Which meanings are lost in translation?  

● Outcome: Students understand AI’s strengths/limits in translation.  

Lab 7: Text Summarization of Articles (Languages / Literature)  

● Tool: SMMRY (https://smmry.com/) or   

Scholarcy Free Summarizer (https://www.scholarcy.com/article-summarizer)  

● Task: Take a long article or essay.  

● Procedure:  

1. Paste article into tool.  

2. Generate summary.  

3. Compare AI summary vs. student’s manual summary.  

● Observation: AI captures main ideas but may miss nuances.  

● Outcome: Learn how AI helps in academic reading & summarization.  

Lab 8: Talk to a Free Chatbot  

● Tool: ChatGPT Free or Poe or any other related tool  

● Activity: Students ask questions like:  

○ “Tell me a Telugu proverb and its meaning.”  

○ “Explain World War II in 5 simple lines.”  

● Outcome: Data delivery/output stage - AI as a dialogue system.  

Lab 9:  Story Generator (Creative Writing / Literature)  

● Tool: AI Dungeon (https://play.aidungeon.com/) -free play or DeepAI Text Generator  

(https://deepai.org/chat/text-generator)   

● Activity: Give a starting line (e.g., “Once upon a time in Amaravati…”) → AI continues  

story  

● Outcome: How training data influences creativity in AI.  

Lab 10: AI Art Generator (Culture & Arts)  

● Tool: DeepAI Text-to-Image (free) (https://deepai.org/machine-learning 

model/text2img) or any other related tool  

● Activity: Ask students to generate:  

○ “A painting of Bharat Mata in Picasso style.”  



○ “Hyderabad Charminar in futuristic design.”  

● Outcome: Data pipeline applied to images.  

Lab 11: AI Music Generation with Soundraw (Free Trial)  

Tool: Soundraw.io  

Steps:  

Open the website → Click Create Music.  

Select Mood (happy, sad, chill, dramatic).  

Select Genre (pop, jazz, cinematic, lo-fi, etc.).  

The AI will generate a full instrumental track.  

You can adjust instruments, tempo, and structure.  

Outcome: Students understand how AI composes music automatically based on mood/genre →  

linking to psychology, culture, and media studies.  

Lab 12:  Chatbot Roleplay (History / Social Science)  

● Tool: Character.AI (free, no coding)- https://character.ai/  

● Activity: Talk to AI characters like “Einstein” or “Shakespeare” and ask them questions.  

You can try with other AI characters and experiment.   

● Learning: How AI mimics personalities using training data.  

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any other  

similar tool to execute the said lab experiments. 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

APPLICABLE TO MATHEMATICS, PHYSICS, CHEMISTRY AND ANY OTHER 

MATHEMATICAL SCIENCES 
Course Code Title of the Course L S/M P C 

25CHE202S  Applications of Artificial Intelligence  3  3 

Prerequisites Basics of Artificial Intelligence 

 

COURSE OBJECTIVES 

1 
Provide a foundational understanding of AI platforms, data pipelines, and their importance in 

the physical sciences. 

2 
Provide a foundational understanding of AI platforms, data pipelines, and their importance in 

the physical sciences. 

3 
Explain how AI is applied to solve scientific problems, discover patterns, and support research 

in physical sciences in a simple, non-coding manner. 

4 
Highlight ethical concerns, data challenges, and the future of AI-driven discoveries in physical 

sciences. 
 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Explain the AI ecosystem (hardware, cloud, and edge devices) in 

relation to physical sciences applications. 
Understanding 

CO2 
Identify scientific data types and public repositories relevant to 

physics, chemistry, mathematics, and earth sciences. 
Understanding 

CO3 
Describe the process of preparing and managing scientific data 

pipelines. 
Understanding 

CO4 
Illustrate the role of AI in solving real-world scientific challenges in 

physics, chemistry, mathematics, and earth sciences. 
Applying 

CO5 
Discover ethical, environmental, and societal impacts of AI-driven 

scientific applications. 
Applying 

 

 

 

 

 

 

 



Syllabus 
 

COURSE CONTENT 

UNIT I 

Infrastructure and Platforms for Building Applications using AI:  

 

Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, 

Memory - RAM, VRAM, Storage - HDD, SSD  

Platforms for building applications using AI: Online platforms (Example - Google 

AutoML, H2O.ai; Desktop (No-code/Low code) platforms (Orange Data Mining, 

KNIME.  

Edge AI: Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, 

Surveillance Cameras, Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT II 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI: 

 

Importance of data in building AI applications: Data as the fuel for AI, Role of big data 

in training AI models.  

Conceptual Foundations of Data: Data vs. Information vs. Knowledge.  

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI).  

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Google Dataset Search or similar ones - for demonstration only), Dataset licensing and 

usage rights.  

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Ethical use of 

data, Responsible AI data practices. 

UNIT III 

The AI Data Pipeline: From Collection to Model Readiness:  

 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models  

Core Components: Ingestion, Storage, Processing, Validation, Delivery  

Data Collection Methods for AI: Manual Input (Surveys, forms, human-curated entries), 

Sensors & IoT Devices (Real-time data from physical environments), System Logs & 

Transactions, Web Scraping (Automated extraction from websites), APIs (Structured data 

access from external platforms)  

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation;  

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: 

Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: 

Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data.  

Data Splitting: Splitting data into training set and test set.  

Data Transformation Techniques: Normalization, Transformation. 



UNIT IV 

AI in Physical Sciences (Physics & Chemistry Applications)  

AI in Physics:  

AI for analyzing astronomical images (identifying galaxies, stars, exoplanets).  

AI in material science: discovering new superconductors and quantum materials  

AI in energy: predicting power grid loads.  

AI in Chemistry:  

Protein structure prediction (AlphaFold).  

AI in drug discovery - virtual screening of compounds.  

AI in chemistry - reaction outcome & material property prediction. 

UNIT V 

AI in Mathematics and Earth Sciences:  

AI in Mathematics:  

Pattern recognition in large datasets (fractals, chaos systems, number theory)  

Automated theorem proving and symbolic mathematics  

AI in optimization problems (transport, logistics, resource allocation)  

(Explore the Wolfram Alpha Tool: https://www.wolframalpha.com/examples/mathematics)  

AI in Earth Sciences Climate modeling:  

AI predicting weather patterns, cyclones, and long-term climate change  

Remote sensing: AI analyzing satellite images for deforestation, urbanization, and natural 

resource mapping  

Earthquake and natural disaster prediction using sensor networks  

AI in geology: identifying mineral deposits, oil, and groundwater reserves 

 

 

TEXT BOOKS 

1. 
Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, cleaning, 

and visualization without coding) 

2. 
AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world 

use cases). 

REFERENCE BOOKS 

1. 
Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 

quality, preprocessing, and pipelines). 

2. 
Hands-On Data Science for Non-Programmers, David Meerman Scott  

(Spreadsheet-based data exploration and visualization). 

3. You Look Like a Thing and I Love You – Janelle Shane 

WEB RESOURCES 

1. 

AI in Astronomy: https://www.borntoengineer.com/how-is-artificial-intelligence-is-helping-us-learn-about 

the-universe https://primo.ai/index.php/Astronomy  

2. 

AI in Material Science: https://deepmind.google/discover/blog/millions-of-new-materials-discovered-with-

deep learning/ https://www.temasek.com.sg/content/dam/temasek-corporate/news-and 

views/resources/reports/ai-meets-materials.pdf   

https://primo.ai/index.php/Astronomy
https://www.temasek.com.sg/content/dam/temasek-corporate/news-and%20views/resources/reports/ai-meets-materials.pdf
https://www.temasek.com.sg/content/dam/temasek-corporate/news-and%20views/resources/reports/ai-meets-materials.pdf


3. 

AI in Energy: https://www.xenonstack.com/blog/ai-renewable-energy-production 

https://www.sandtech.com/insight/how-ai-is-transforming-the-future-in-energy management/  

4. 

AI in Chemistry: https://chemintelligence.com/ai-for-chemistry  https://deepmind.google/science/alphafold/  

https://aimagazine.com/articles/alphafold-2-the-ai-system-that-won-google-a-nobel-prize   

5. 

AI in Drug Discovery: https://www.ddw-online.com/the-promise-of-ai-advancing-drug-discovery-with-ultra 

large-library-processing-29063-202403/ 

6. 

AI in Optimization Problems: https://throughput.world/blog/ai-in-transportation-and-logistics/ 

 https://codewave.com/insights/ai-transforming-transportation-logistics/  

7. AI in Remote Sensing: https://www.satimagingcorp.com/applications/artificial-intelligence-ai/  

 

 

CO-PO Mapping:  
 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

Model Blue print for the question paper setter 
 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 

https://www.sandtech.com/insight/how-ai-is-transforming-the-future-in-energy%20management/
https://chemintelligence.com/ai-for-chemistry
https://deepmind.google/science/alphafold/
https://aimagazine.com/articles/alphafold-2-the-ai-system-that-won-google-a-nobel-prize
https://www.ddw-online.com/the-promise-of-ai-advancing-drug-discovery-with-ultra%20large-library-processing-29063-202403/
https://www.ddw-online.com/the-promise-of-ai-advancing-drug-discovery-with-ultra%20large-library-processing-29063-202403/
https://throughput.world/blog/ai-in-transportation-and-logistics/
https://codewave.com/insights/ai-transforming-transportation-logistics/
https://www.satimagingcorp.com/applications/artificial-intelligence-ai/


 
Applicable To Mathematics, Physics, Chemistry and Any Other Mathematical 

Sciences - 

Semester-II 
 

Recommended Format of Question Paper  
Time: 2 ½ Hrs                                                                                                Max. Marks: 

70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.                                    

 5X10=50 

11. A) From Contents of Unit-I 

OR 

B) From Contents of Unit-I 

12. A) From Contents of Unit-II 

 OR 

B) From Contents of Unit -II 

13. A) From Contents of Unit -III 

        OR 

B) From Contents of Unit -III 

14. A) From Contents of Unit -IV 

        OR 

B) From Contents of Unit -IV 

15. A) From Contents of Unit -V 

        OR 

     B) From Contents of Unit –V 

***** 

 

 



 

 

 
Applications of AI  

MODEL QUESTION PAPER (W.E.F 2025-2026): Applicable to Mathematics, Physics, 

Chemistry and Any Other Mathematical Sciences 

Time: 2 ½ Hrs. Max Marks: 

50 
 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1  Explain about any online platform to build AI application. 4M 2 1   

2 State about the Edge AI in smart Appliances. 4M 1 1   

3 Write a short note on “Structure of Data”. 4M 1 2   

4 Explain about Modalities of Data. 4M 2 2   

5 Define the process of Data Annotation and Labelling. 4M 2 3   

6 Discuss about various data collection methods for AI. 4M 2 3   

7 Write short note on AI for analyzing astronomical images 4M 1 4   

8 Discuss about AI role in Protein structure prediction 
(AlphaFold) 

4M 2 4   

9  Explain about Pattern recognition in large datasets. 4M 2 5   

10  Identify the AI role in geology. 4M 2 5   

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 a) Explain the hardware components for building AI 

applications? 

(OR) 

b) Explain briefly about AI in applications in daily 

life appliances? 

10M 

 
 
 

10M  

2 

 
 
 
2 

1 

 
 
 
1 

  

2 a) Explain the importance of data in building AI 

applications? 

(OR) 

b) Discuss about data repositories and data licensing 

in AI? 

10M 
 

 
10M  

2 
 

 
2 

2 
 

 
2 

  

3 a) Summarize about Stages and Components AI 

Data Pipeline? 

(OR) 

b) Distinguish between Data Cleaning/Preprocessing 

and Data Splitting? 

10M 
 

 
10M  

2 
 

 
2 

3 
 
 

3 

  

4 
a) Show how AI plays its role in material science. 

 

(OR) 

b) Illustrate the role of AI in drug discovery. 

10M 
 

 
 

10M  

3 
 

 
 
3 

4 
 

 
 
4 

  

 5 a) Discuss about AI in Automated theorem proving 

and symbolic mathematics? 

(OR) 

b) Explain about AI in Climate Modeling? 

10M 
 
 

   10M  

2 
 
 

   2 

5 
 
 

5 

  

 

 
 

**All the Best** 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
APPLICABLE TO MATHEMATICS, PHYSICS, CHEMISTRY AND ANY 

OTHER MATHEMATICAL SCIENCES 
Course Code Title of the Course L T P C 

25CHE202L Applications of AI   2 1 

Prerequisites Basic Knowledge in AI 

Practice Session 

Suggested Lab Practicals (No Coding)  

Lab 1 - Exploring Public Datasets (Orange Data Mining)  

● Visit a public repository (Kaggle, UCI, data.gov.in)  

● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics)  

● Procedure:  

1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset).  

2. Connect to Data Table → View rows/columns.  

3. Connect to Data Info → Check attributes, data types.  

4. View in Data Table and Distributions widget.  

● Observation: Note numeric, categorical, missing values.  

● Outcome: Students understand structured data format in CSV.  

Lab 2 - Exploring Scientific Datasets   

Dataset: Earth datasets, Physics Particle Dataset  

Tool: Orange Data Mining.  

Activity:  

● Load a CSV (e.g., earthquake dataset:   

https://www.kaggle.com/datasets/warcoder/earthquake-dataset  

Physics particle dataset: https://www.kaggle.com/datasets/dsfelix/physics-particles)  

● Use Data Table + Distributions to view features.  

● Compare categorical vs numerical attributes.  

Outcome: Students understand how scientific datasets are structured and visualized.  

Lab 3 - Understanding Dataset Metadata and Formats  

● Take two datasets in different formats (CSV, JSON)  

● View metadata (description, features, size, license)  

● Compare domain-specific datasets (e.g., medical vs. finance)  

Lab 4 - Data Annotation Exercise  

● Use MakeSense.ai or VGG Image Annotator (VIA)  

● Annotate 10 sample images (traffic signs, fruits, or medical scans)  

● Export annotations in XML or YOLO format  

● Discuss annotation errors and challenges  

 

 

 

 

 

 

 

 



 

 

 

Lab 5 - Data Cleaning and Visualization (Orange Data Mining)  

● Aim: To clean dirty data and visualize categorical and numeric attributes.  

● Procedure:  

1. Load dataset.  

2. Connect File → Edit Domain (to change types) and Impute (to fill missing values).  

3. Compare cleaned vs. original in Data Table.  

4. Distributions widget.  

5. Check various features distribution.  

(Optional: Create simple bar charts/line charts to visualize trends using Google Looker  

Studio)  

● Observation: Missing values filled with mean/median., Graphical representation of data.  

● Outcome: Learn importance of data cleaning., Students learn importance of visualization  

in preprocessing.  

Lab 6: Train/Test Split in Orange  

● Aim: To split dataset for AI training/testing.  

● Procedure:  

1. Load Titanic dataset.  

2. Connect File → Data Sampler (70% train, 30% test).  

3. Connect outputs to Data Table widgets to view.  

● Observation: Students see two different subsets.  

● Outcome: Concept of model validation using split data.  

Lab 7 – Material Science Data Exploration (Chemistry + Physics)  

Dataset: Materials Project Database (https://next-gen.materialsproject.org/) OR Kaggle  

chemistry datasets  

Activity:  

(https://www.kaggle.com/competitions?tagIds=7402-Chemistry)  

Orange Data  

Load material/compound dataset (e.g., band gap, conductivity).  

Visualize trends (scatter plots, bar charts).  

Identify correlations between features.  

Outcome: Students see how AI identifies  

Lab 8 – Earthquake Prediction Data Analysis (Earth Sciences)  

Dataset: USGS Earthquake Dataset (public):  

https://www.kaggle.com/datasets/rupindersinghrana/usgs-earthquakes-2024  

Tool: Orange Data Mining  

Activity:  

● Load earthquake data (time, magnitude, depth).  

● Plot frequency over time & regions.  

● Perform simple clustering (e.g., k-means in Orange).  

Outcome: Understand how AI detects seismic patterns. Mining. new material properties.  

 

 

 

 

 

 

 



 

Lab 9– Climate Data Visualization (Earth Sciences)  

Dataset: NASA GISS climate dataset (https://data.giss.nasa.gov/gistemp/) / FAO rainfall data  

(https://www.fao.org/aquastat/en/geospatial-information/climate-information).  

Tool: Google Looker Studio (free dashboard tool).  

Activity:  

● Import CSV of temperature/rainfall data.  

● Build trend graphs and heat maps.  

Outcome: Learn visualization of climate patterns & anomalies.  

Lab 10 – Chemical Compound Classification (Chemistry)  

Prerequisite: Discuss conceptually about Clustering  

Dataset: PubChem/ChEMBL (https://pubchem.ncbi.nlm.nih.gov/source/ChEMBL)   

Tool: ChemMine Tools (free web-based). (https://chemminetools.ucr.edu/)  

Activity:  

● Input chemical structures or SMILES notations.  

● Predict chemical similarity clusters.  

● Analyze “drug-likeness” properties.  

Outcome: Understanding AI in drug discovery & reaction prediction.  

Lab 11 – Symbolic Mathematics Solver (Mathematics)  

Dataset: Wolfram Alpha examples / OpenMath datasets.  

Tool: MathPix (OCR) + Symbolab / WolframAlpha (free tier)- https://www.wolframalpha.com/  

Activity:  

● Input handwritten/scanned math problems using MathPix.  

● Use Wolfram Alpha to see symbolic solving.  

● Compare AI vs manual solution steps.  

Outcome: Understand automated theorem proving and symbolic AI.  

Lab 11 – Explore the Mathematical AI tool  

Tool: WolframAlpha (free tier)- https://www.wolframalpha.com/  

Activity:  

● Solve specific math problems or find information on Mathematical subjects and topics.  

Outcome: Understand deep computational power of AI tools in solving Math Problems.  

Lab 12 – Explore various Remote Sensing Datasets  

Tool: https://developers.google.com/earth-engine/datasets/  

Activity:  

● Explore any Three Satellite Sensor Datasets  

● Identify the Significance and the Period of Availability  

● Study various bands available in the data  

Outcome: Understand various Remote Sensing Datasets.  

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any other  

similar tool to execute the said lab experiments. 

***** 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

The Following are planned for this 2025-26 UG – Batch in the coming future. 

 

  A certificate course would be conducted for the students in II Year. 

 The multi-disciplinary and skill-courses would be conducted by various concerned departments 

and the syllabus is approved by concerned BOS members of those departments. 
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